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Some Basic Encompass Functions:

1) To Copy/Paste info, you will highlight the data to be
copied, hit Control + C, then Control + V to paste

2) To locate a specific field# within Encompass (if you know
the field#), you hit Control + G and input the field#

3) To determine a field# simply hover over the field and
the number will be displayed:
As you can see, the field#
for Haz. Ins is 230 —

Rent
FirstMtg. | 000| @ 7177
| &
25000 | 19392
316.00 [ 5 2
E( E 9¢ Insurance re. u lick the Edit icon (if available) to




Some Basic Encompass Functions:

4) Once you know a field#, you can perform an Audit Trail
(many fields, but not all, are able to be audited) rm we s

Amortization Schedule

Anti-Steering Safe Harbor Disclosure

- Audit Trail is located under the Tools Tab ki
- Input the field id# (using “230" from previous slide)

Audit Trail

' ** This will display the
— date/time and the individual

Date User ID First Name Last Name New Yalue °

8M0/2016 T19:49 AM  eummighd 0.00 Who Input the tha
8M172016 1:20:00 PN quuinigh 250.00

812372016 1:54:49 P = 0.00

8252016 33424 P cumigith - 194.00

10/3/20161:59:32P CHENND 193.92
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Milestone Flow & Accountability:
BOLD = completed s =

Branch Processors should # | File Started 111416 A =LO Milestone
select Joe McDonald when Qualificationfinished 114646 = LO Milestone

. . ] +  Application finished 111616 = LO Milestone
assigning the file for % Senttoprocessing MATAE . = LO Milestone

|n|t|0| SmeiSSiOﬂ to U/W 4 ProcessOpenfinished 111716 = | oan SetUp or Processor Milestone
+ | Submitted 112118 = Processor Milestone

— Joe will round-robin # | Cond. Approvalfinishec 112946 = YW Milestone

i | L .
assign to amemberof t = oo Lag® ;E’JCTZ;Z;Z";':“""

b ranc h U/W Team Clear To Close 120816~ = QA/Closer Milestone
Doc Preparation 120916

At the time of Resubmittal, @ Doc signing 121206
re-select the u/w listed in B Fundng 121316

= Closer Milestone

| Shipping 1211416

the system

L
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Milestone Documents/Tasks/Required Fields:

It an item is listed with an asterisk, that box must be check
Marked to complete the milestone

If an item is listed with a “paper clip’, the system requires a
document to be in that folder prior to completing the milestone

Documents [ Fraudiaudit Services €5 Document Details (title vetting)
[[] 001- Underwriting Submission Form [J411.com Valation

T i Details
title vettin
[J usps Address Verification Form " [title vetting
[] Mortgage Statement — ile vetng ‘

(I MLS status Description | |
[] Fraudiaudit Services
411 com Validati . . o . .
I Sﬁtb thg - Best Practice: Click on the Document line item = title vetting

The system will immediately open the folder to load to ensure
proper location for the item needed

L
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Milestone Documents/Tasks/Required Fields:

Example of the Resubmittal Milestone Document Needs:
— This is an FHA Refinance:

= Submittal
| Cond. Approval
| Resubmittal
W] approval
Clear To Close
Doc Preparation
[ Doc signing
(8] Funding
] Shipping
| Purchased

] - “

Forms  Tools Services

(if [JFHA Appraisal AssignmentiLogging Sheet
* [[] Mortgage Payoff Statements
[] wire Instructions
[[] Closing Protection Letter
[ va - nov
[ Invoice - additional 3rd parties
[] Title Report
[C] Homeowner's Insurance Declarations Page
[] Tax Certification

i [0 cover Letter to Underwriter - Final

Flood Certificate received : 0372717

Note: if required
folders are
duplicated, the
system will want
to see something
in each folder, if a
REQUIRED ITEM,
in order to finish
the milestone

You can avoid
this by clicking
on the item
(see previous
slide) instead
of accidentally
creating a
duplicate
folder in the
eFolder
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Milestone Documents/Tasks/Required Fields:

All items in the Required Fields guadrant must be completed prior
to finishing the milestone

— Many fields are mapped to their location, if you click "Go to
Fields”, the system will take you to the screen where the data

s located
— ** Note: the ability to complete information directly on this
screen was disabled due to data integrity issues

 Required Fields GotoFieds || Field Summary

Borrower Intent to Continue Date




Milestone Comments:

This quadrant is useful for making general notes regarding
loan status, items ordered, notes regarding the borrower, etc

To add a new note, click the Date Stamp and add your note

To see the notes in ALL milestones, click “Show All”

Milestone Comments Date Stamp ]

03/27/17 10:42 AM (EST) Derrick Sigler > Ordered Alyson's VOE faxed to 303-582-0887
03/27117 10:49 AM (EST) Derrick Sigler > FHA CASE # Held for Duplicate Address with check tomorrow

Submittal

Cond. Approval

L
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PRINT ICON

To print the U/W Conditions:

M eFolder | =

Print
Print
Form Groups Standard Forms Custom Forms

Form Groups Standard Forms

LookIn | [ Condtion Forms

Name This or That.... Lookin | {5 Compenywide
Condition Assignments < > Name

[) Conditional Approval Letter Grouped by Condition Category Approval Letter
[7) ARM Disclosure

nations
lending




Form Groups Standard Forms

PRINT ICON

To print an HOI Mtgee Change Request, Title Request Form,
etc:

Custom Forms

Look In

(22 Companywide

Name

[F] Certificate - Approval v20150106
[7) Certificate - Pre Approval v20150106
[F] Certificate - Prequalification wicredit v20150106

Selected Forms (3)

Name
Hazard Insurance Endorsement Letter - NLC

wmest Form - NLC Custom v.08112011

nations
lending




PRINT ICON

To print the SSA Authorization:

Print / 4

Standard Forms Custom Forms

b Verifications

VOL (6). DISCOVER FIN SVYCS LLC
@ vl (7Y CARITAI ONE

[} SSA-89 Social Security Number Verification (Borrowver)

) SSA-89 Social Security Number Verification (Coborrower)

< >

nations
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THE EFOLDER

Paperless File Management

2
Split/Merge

Drag & Drop

nations
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eFolder > File Manager:

R eFolder | = -_ EFILEMANA@ER

- Where the Unassigned Documents are located

» You can browse/load, scan, drag/drop from desktop

- Review documents to drag to eFolder "buckets”

- Leave the "junk” in the File Manager

- [tems that are “deleted” from the efFolder buckets flow here

ot Manager | Fie Manager | Send v |

i €5 File Manager

B > B | 3| | AutoAssign

Size Date

.
B9 Compliance Report
B9 Compliance Report 3032 KB

nations
lending




The eFolder View — Documents Tab:

€ Encompass eFolder

eFolder Documents Help

Documents  Preliminary Conditions  Underwriting Conditions  Post-Closing Conditions ~ History

Standard View Use v

Document Group  (All Documents) Stacking Order E

Documents Tab= all loan disclosures,
3rd Party Iltems,
& Borrower Documents

nations
lending




The eFolder View - adding folder(s)/bucket(s):

If you need to ADD a folder document that is not currently displayed in the eFolder
view, click the “New Document” icon.

— For example, your borrower may have been divorced and has child support
documentation, you would need to ADD these folders:

l 1) Click here

v

Document Group ' (All Documents) v‘ Stacking Order | None

Documents (216) RO 5 HLE| econsent

A v Fo Name Received On Received By For Borrower Type

2) This

pop-up 3) If you know the name
WiII of the fOIder, type the € Document Details (Docs to be signed at closing)

Add Document Details

appear © st e document first letter to get to that | ... — -

° Deectbion Proof of Delivery (Not of Inc App) A
. Disclosure- Proof of Delivery (Other Redisclo
CI. k OK (O Add documents from Document Sets SeCtIOn, Diackosurs. Proof of Delvery (Rate Lock)
I C . Disclosure - Proof of Delivery (Read Receipt)
Disclosure Notices
otherwise, scroll fosorouer (Jecomueteices
Disclosure Package FHA

For Milestone

Docs to be signed at closing
E Access Document Preparation ! \ ’

Downpayment Assistance Documentation

= Earnest Money Check-Purchase .
Conditions | |\ caronic Mail Disclosure Acknowledaement nations

lending




The eFolder View - adding folder(s)/bucket(s):

Document Group ' (All Documents) v‘ Stacking Order rNone v-

Documents (216) R - 2 BE| econsent

A v Fo Name Description Received On Received By For Borrower Type
1) Click here
Once you have created the folder, you can I

immediately load the documents either

oy browsing your computer or pulling
documents from.the unossigned section
O'F the F||e MQHOQ 4 | €2 Document Details (CA Privacy Policy Disclosure)

Details

Name CA Privacy Policy Disclosure
CA Privacy Policy Disclosure
Canceled Check

_ 5  a Cash To Close Purchase
Ji,

B > B & w v | :.;] [ Child Support Documentation
Clear to Close Certificate

Closed Accounts Letter

- O

L
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The eFolder View — Document Folder Use

Most folders are logically named to match the documents being loaded,;
.e. pay stubs, W-2s, Bankruptcy Papers, etc

Here are some that may not be so obvious:

| Mortgage Statement v |= Mortgage Statement(s) for the Subject Property ONLY

| Proof of PITI Other REO | = Mortgage Statement(s), proof of HOI, proof of Taxes, etc for all properties
OTHER THAN the Subject. Best Practice = create a separate bucket for each address

I Mortgage Payoff Statements

v |= Mortgage Payoff(s) for the Subject Property & any other REOs being paid in full

I‘Payoffs non-mortgage vI = All other payoffs, i.e. credit card statements, Installment Loans, Judgements, etc

I Income Verification and Abilty to Make Payme ~ | = 1 NiS is NOT a folder for Income Verification docs; this is used for an IVF form
In the states of PA, VA, & IL only

L
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The eFolder View — Document Folder Use
Commonly-used folders & their importance

I Docs to be signed at closing v I = ALL documents that must be SIGNED, REVISED, INITIALED, etc at Closing

| Large Deposit Documentation v |= Documentation to satisfy Large Deposits on Bank Statements goes here

|hvoioe-addtional 3rd parties v| = Any/All Invoices to be paid at closing, with the exception of
Appraisal Invoice & Credit Invoice (they have their own folders)

I ‘Unsigned Attachments v I = Once the signed disclosures are returned via DocuSign,
all BLANK/unsigned disclosures are compiled into this folder

I Do Not Ship v I = Place all documentation that would normally be left in
the File Manager into this folder; the “junk”

20 I

nations
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The eFolder View — Document Folder Use

Title Docs should be separated into the following folders:

‘ Closing Disclosure- Prelim \= ONLY the Prelim CD; keep only the most recent version

‘ Closing Protection Letter ‘ = ONLY the CPL; < 60 days old; if score <580, then <30 days old

Tax Certification |= Tax Cert and any supporting documentation, as needed

| |Wire Instructions \l = ONLY the Wire Instructions

Title Report | = Title Report and any additional documents
that don't fit into the other four categories

20 I
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The eFolder Pipeline:

While in a document folder, anything typed into the
“Description” box will appear on the eFolder pipeline view

Details

Name Bank Statements - All Pages - Assets v

Description Anything typed here shows up on the
eFolder Pipeline View|

Documents (216)
At.. v For.. Name Description Received On

ﬂ ATRIOM Worksheet ATR/GM Worksheet 1011916 08:30 PM
“- Bank Statements - All Pages - Assets Anything typed here shows up on the eFolder Pipeline View 100316 12:23 PM

L
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The eFolder View:

Underwriting Conditions Tab = all u/w conditions,
Including Suspense Conditions

€ Encompass eFolder
eFolder Documents Help

Documents  Preliminary Conditions  Underwriting Conditions  Post-Closing Conditions  History

Standard View Use v

Document Group  (All Documents) Stacking Order \]

nations
lending




eFolder > Underwriting Conditions — attaching
documentation

For each condition, double-click the item to open the full condition:

Documents  Preliminary Conditions  Underwriting Conditions  post-Closing Conditions ~ History

Dawn's Cleared v

Underwriting Conditions (14)
Do Name & Description Fulfilled By Fulfilled On

L | [ -

Appraisal Full Interior/Exterior appraisal required to...
Credit - LDP/GSA Approvalis subject to satisfactory review...
Income - Verbal Verification Of Employment  VWVOE dated 3/9 or after to cover a full 2...
Miscellaneous Attach any documents UW should review ...
Prior to Approval Condition Verify subject city discrepanciesis it You...

~e -

nations
lending




eFolder > Underwriting Conditions — attaching conditions

Many of the “standard” conditions will already have the
"bucket(s)” attached that would normally be used to clear the
condition

Details Supporting Documents

o ) - -
Appraisal
& Appraisal Invoice

Full Interior/Exterior appraisal requiredto A \ wal  Appraisal
establish value sufficient to support
requested LTV/CLTV. Appraisal form# (as .,

Once the bucket for Appraisal and Appraisal Invoice are “filled”
iINn the Documents Tab, the items will already be associated to
the condition because the buckets/folder were pre-attached




eFolder > Underwriting Conditions — attaching conditions

If a required bucket/folder is not already - O X
pre-attached, simply click the "Assign” button & 3 & X || rewest

At Name & For Borrower Pair Access Status Date
& va-nov Ryan K and Lindsay M K...  AC, AP, BM, BP,..  Received  03727/17

Name VA - Notice of Value (NOV) Conditions |

3 Details [ Supporting Documents
b

Description All conditions of the NOV must be satisfied

|

' || Assign Documents

= Documents

At Name & For Borrovver Pair
[ Tax Certification Ryan K and Lind A
Termite/Pest Inspection Ryan K and Lind
|& Title Report Ryan K and Lind

This will open up the Document Folders

— Highlight the folder(s) required to satisfy the condition; you
can hold the "CTRL" button down to select multiple folders

U WUV wial aun wwv-l'|

— Click Assign >
assgn || cancel | () Wi

nations
1 lending




eFolder > Underwriting Conditions — attaching conditions

You will notice that we now have the Termite/Pest
INnspection associated to the condition:

Supporting Documents
At Name & For Borrower Pair Acce
il Termite/Pest Inspection Ryan K and Lindsay M K... AC,,
All conditions of the NOV must be satisfied wal VA -NOV Ryan K and Lindsay M K... AC, .

VA - Notice of Value (NOV) Conditions

View More >

For Borrower (eemesseematitioniosiy HB8|¢ ®|QAQ12s% ||

Pair
Source { dotloop signature verification:

Category

Prior To

Owner Allow to Clear l w°°d wnl 'm
| Section I. General Informatio

nations
lending




eFolder > Underwriting Conditions — attaching conditions

03/08/17 02:29 PM

tedwards

03/2717 05:33 PM

dthompson

Once all documents
required to satisfy the
Condition Description are
associated to the
condition, checkmark the
Fulfilled Box - this will
populate the name/date
to the conditions view

Description

Fulfilled By Fulfilled On

= v

Full Interior/Exterior appraisal required to...

dthompson 0372717 05:33 PM

nations
lending




eFolder » Underwriting Conditions — Comments

If an underwriter needs to provide
additional guidance on a specific
condition or rejects a condition, they
will generally place notes in the
Comments Tab:

This is a good place for the processor
to place notes or responses to the u/w
comments

Details

Name Assets - Retirement Account Terms & COnditionel ‘

Description Borrower(s) to provide the terms and A
conditions of withdrawal from their
401k/retirement account. - provide v

View More > | |

For Borrower Ir
Pair

Source IManuaI

Category Assets

Prior To

ack Processor Allow to Clear

Print Internally

Tracking

Status Comments

Comments D &

| 02/17/117 03:00 PM awillhite > Statement is over 120 days
old - need updated statement

20
19

L
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FORMS TAB

Show in Alpha Order
Show All




1003 - pqge 1: Forms  Tools Services

1003 Page 1

— Ensure that Interest Rate and Qual Rate = ™=omim e
are EQUAL unless doing an ARM product  ourse | 3250/

— Confirm accuracy of Subject Property Address and # of units;
generally based on USPS and/or legal description from the

county

Il. Property Information and Purpose of Loan

Subject Property

Address 5504 Mulberry Dr County |Broward
City Tamarac No Units 1 Year Built | 1971‘]
State FL Zip 33319

L
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1003 - Page 1:

— Ensure that the Title will be held section is accurately
completed

* 7 NOTE: if you are doing a REFINANCE and the current title vesting is
accurate, the Encompass file should be set up to match current title

vesting with regard to the name(s)
— This avoids AKAs and multiple sets of docs being signed at closing

Title will be held Estate will be held in

Names @ | |Fee Simple |V
a If Leasehold, enter expiration date:
Manner | Unmarried man /] -3

L
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T— -

1003 - Page 1: e
— Be sure to confirm a FULL 2 year Residency v "oz o om (e

| ’ Mailing Address Same as present

History & proper mailing address is input p———

* Click Show All (VOR) to add an - ] e
additional address R —

Address ’

— Be sure to verify a COMPLETE 2 year A S——
Employment History sorveas [ J¥ [ O ow

* Click Show All (VOE) to addj()bs IV. Employment Information
« The 2 years should be provided based on e =K

L] Self-Employed

Ap P lication Date Employer | BROWARD COUNTY SHERIFF OF| (i)

Address | 7515 NW 88TH AVE

« ** NOTE: FHA specifically requires a 2 year W [Tamarec }
WORK HISTORY - periods of unemployment do 5 = [ 2 [ 1

Posion | BAILIFF

not count towards the 2 year period B.Phone TE

Years in Line of Work | 3|
20

L
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Forms  Tools Services

1003 - Page 2:
— Ensure that the Income Section is BROKEN-DOWN,;
income should not be “lumped” into one total figure:

— If there is O/T, Bonuses, Commissions, I ——
etc — this should be listed in its own field Fomng o vma e [ ]

Base

Overtime First Mig. 1,850.00| [ & 133171

— Do NOT use the lock box for Net Rent; Gonuses overra. | @

Commissions Haz. Ins | | 313.18

Net Rent Inc. Mig. Ins

l
data should be input correctly in the REQ o el E{ET

| @

screen to flow to this field o e o —

(| Total 8,942.01 8,942.01  Total 1,850.00 2,070.83

— "Other Income” should be selected from | onericone

B/C Description Monthly Income

the dropdown choices whenever possible = [osremeiomenms sasns

B ’ VA Benefits NonEducational

1

nations
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1003 - Page 2:

— Ensure that Present Housing Expenses are accurate and broken-
down

« Regardless of loan type, the “Present” expenses are ALWAYS the owner-occupied housing expenses

— Ensure that the Proposed Haz. Ins, RE Taxes and any other figures
are accurately input

— “ For an owner-occ Refi, the Haz. Ins and RE

Monthly Housing Expenses

Present  proposed Taxes should match; present = proposed
Fest i, %mw CEIRETD " HOA dues would be input on this screen

Other Fin. | &

vz ve | “? ~ Flood Insurance, if applicable, should be

RETaxes |  321.94] 321.94 |

wem [ @3 entered on the 2015 ltemization (see next slide)
over | @ o and the data will flow to this screen (in “other”)

Total 1,954.00 2,070.83

20 I
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1003 - Page 2: Inputting Flood Insurance, if applicable

— Step 1: Go To the 2015 Itemization and input the monthly
oremium on Line# 1006

7 | 1004. Property Taxes S mths @S [? 31.25
Forms  Tools  Services v . j '

71 1005. City Property Tax mths @ $
2015 temization A 1 e - —I — -
AAARefinance Qualification Form : § N s@

Additional Disclosures Information Z | 1007. l'_‘ T°1 i ‘ This will flow to 1 003-page 2

— Step 2: Complete the Aggregate Setup = input the "2 month

cushion” and place a 12" in the box for the policy expiration
(neXt due) date 1011, Aggregate Adust. B[

62.50 Aggqi ﬁl ‘ ||
* Wil be added ta

Initial Escrow Account Setup

) 1100. Title Ch
Escrow First Payment Date: 04/01/2017
Date Tax Haz Ins Mtg Ins Fid Ins

1101. Title hsura1 Cushion 2 2 2
Meem Pimin 4 12/01/2017 02/01/2018

L

nations
lending




1003 - Page 2: Inputting Flood Insurance, if applicable

— Step 3: If the full Flood Policy Premium will be paid in this loan,
input the full premium, 12 months, on Line# 906

* If inputting “12" in the months field is not 100% accurate, then you

may utilize the “lock box” to input the true/correct premium amount
<

” 1 905. VA Funding Fee Veterans Adnlistraﬁon s 204250

” 906. Flood Insurance  CBC l W@ 101580 |

| 12mths @5 84.65

] = [

nations
lending




1003 - Page 2: Inputting/Confirming Accurate Mtg. Ins

ALL forms of Ml are input by utilizing the paper/pencil button
from the Monthly Housing Expenses: Hazins | 3B48) (| 31318
9|
{LLH

RE Taxes 321.94 |

— CONYV loans can be either monthly (BPMI), g Ins

9 (=)

single-pay, Split, or LPMI (see SharePoint > HOADues | 10400, 104,00
Mortgage Insurance — CONVENTIONAL loans > NLC MI Matrix
for further explanation) - ** we do NOT offer Lender-Paid

Monthly
— FHA loans will have both an Upfront MIP & a Monthly Ml

— VA loans, if not exempt, will have only an Upfront MIP (also
answer bottom section of Ml screen)

— USDA loans will have both an Upfront MIP & a Monthly Ml




1003 - Page 2: Inputting/Confirming Accurate Mtg. Ins

Upfront ;noqchuunec Pl;ﬁlll I Funding / Guarantee Fee

Base Loan Amount

MIP / Funding / Guarantee

Amount Paid in Cash [J Lock
Upfront MIP/Funding/Guarantee Fee Financed
Loan Amount with Upfront MIP/Funding Fee

[J Refund prorated uneamed Up Front
[[] Round to nearest $50
[[] Charges for the insurance are added to your loan payments
[[] Charges for the insurance are collected upfront at loan closing
[J Lender Paid Mortgage Insurance

MI Factor Field Locked

[ ]

Monthly Mortgage Insurance
Calculated Based On | Loan Amount v | GetM

1| |4l | Months
2 | 5 | Morths

Cancel At %
l] Calculate based on remaining balance
[C] Midpoint payment cancellation
Declining Renewals

Number of Months Ml being Collected [ ] Prepaid
Prepaid Amount

305,995.00

11

Mortgage Insurance (FHA and VA)

Type of Veteran 1
[ Is this the first use of the VA loan program?

1] - used for FHA; USDA: VA, unless exempt; CONV, if Borr Single Pay or Split

HE - used for CONV, if borrower will pay Mlin cash at closing

H3 - check-mark if doing LPMI (Lender-Paid Mortgage Insurance)

1141 - used for FHA; USDA; CONV if doing BPMI

1S — used for CONV, if doing BPMI (MI cert will show breakdown for boxes 1 & 2)

HE - for CONV - Primary/2nd home, % will be 78%; for CONV - Investment, 0%:;
if doing LPMI, % will be O%; left Blank for FHA, VA, and USDA

1/ - check-mark for FHA; check-mark for USDA
H8 - check-mark for CONV Investment Properties (all Ml types except LPMI)

H9 -~ CONV loan - input # months, if applicable, per Ml Cert; most will be “0O”
#10 - Completed this section if doing a VA Loan

#11 - for FHA loans, once FHA Management screen is completed, click to ensure
accurate data; Encompass is programmed to complete accurately

L
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Ml - Adding to Aggregate Setup

Whenever CONV Monthly Mortgage Insurance is being
utilized, be sure to add the following to the Aggregate
Setup of the 2015 Itemization:

Escrow First Payment Date: 05/01/2017

Date Tax Hazlns  Mtglns
Due Date 1 11/01/2017 02/01/2018 05/01/2017
Due Date 2 06/01/2017
Due Date 3 07/01/2017
Due Date 4 08/01/2017

05/2017
06/2017
072017
08/2017
08/2017
102017
112017
12,2017
01/2018

B S I T S S Gy S A S G —Y




1003 - Page 2:

— Ensure that the MOST RECENT assets, if applicable, are input
accurately
« Use the Show Al (VOD) button to access the assets
* Use the paper/+ symbol to ADD new Qccognts

(37

Belong To Bank/S&L/Credit Union Balance
Borrower Wells Fargo 2,041.91

Account Information

Account Type / Account in Name of Account Number/ Balance
Checking Account Pete James Jr 1326 Y 1,000.71

Savings Account Pete James Jr 9603 1,041.20
| |

L
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1003 - Page 2: Confirm if CREDIT is Joint or Not Joint

— You may receive errors when running AUS if this is not
completed accurately:

Forms  Tools Services

Borrower Summary - Origination
Notice of Incomplete Application

1003 Page 1

1003 Page 2

1003 Page 3

2015 temization

Loan Estimate Page 1

Loan Estimate Page 2

Loan Estimate Page 3

Request for Transcript of Tax (Classic)

v

/4

VI. Assets and Liabilities

| Completed (| Jointty [] Not Jointly

Assets

Cash Deposit

Checking and Savings

Total Bank Deposits

{

Real Estate Owned
Vested Interest in Retirement Fund \
Net Worth of Business Owned [

Automobiles Owned

Make and Year
[

nations
lending




1003 - Page 2:

— Ensure that the Liabilities Section is accurate =
EVERY account listed on credit should be reflected in the liabilities
Confirm that HELOCs are correctly reflected in the “Type” column
Time Shares should be listed as INSTALLMENT “Type”
Confirm that Open-type AMEX accounts reflect as "Open 30-day charge”

Student Loans - be sure to enter a Payment unless loan type is VA and
student loan is deferred for > 12 months

Collection Accounts (non-medical) - ensure that a 5% Payment is entered, if
required by agency guidelines

f OMITTING a debt from the DTI, be sure to provide supporting
documentation as needed; use the “Exclude from URLA" box in Show All

(VOL)

* NOTE: Encompass does NOT count “Mortgage” Type accounts from the
Liabilities section with regard to DTI; these are counted from the REO screen

nations
lending




1003 - Page 2:

— Any Alimony or Child Support PAYMENTs being made BY the
Borrower should be reflected here, at the bottom of the

eage:

Description Payment Mos Left
Alimony / Chid Support
Job Related Expense '




10 O 3 - pq ge 3 . 1003 Page 3

— Ensure that the REO section is accurately completed - click

Show All (VOM) to access the properties list
» Use the Paper/Plus to add Additional Properties as needed

VI. Assets and Liabilities (continue)

Schedule of Real Estate Owned ﬁ Show All (VOM)
Market Value  Amount
Totals 322,100.00 2233 Quick Entry - VOM

Additional Credit Received VoM

Alternate Name crd Property Is Address
' I | Primary Residence 5504 Mulberry Dr, Tamarac, FL 33319

h—

]

L
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1003 - Page 3: REO Section

— If the REO is the Subject of the Loan, the "Subject Property”
box should be check-marked

Click to attach mortgage | Address |5504 Muberry Dr Subject Property Select the correct property usage;

liens In the liability \Cty Tamarac | |Primary Residence  [v] | *+if property is Investment, “R” should

section State FL Zp |33319 always be selected for Property Status

Attach/Show Liens ; Mortgage Balance )
Present Market Value ] Mortgage Payment @

\n o

Property Status (S,PSR) ~|  Gross Rental Income \ . It & i
Type of Property | Single Family Taxes, Ins, Expenses , axes a insurance are

Purchase Price SelecLEmpeLtyJ Percentage of Rental not included in the

ate uir Participation %
Property Status: | o Type ’ Mortgage Payment

S=Sold dropdown tetincome [Loss above, add here

PS = Pending Sale L™= |
R = Rental (Investment) NS}

nations
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1003 - Page 3 - Setting up Investment Properties in the REO:

Step 1= Calculate the Gain/Loss

1003 Page 3 10

«  b. Alterations

VL. Assets and Linbitties continue) using the 1084 Worksheet

Schedule of Real Estate Owned

arketVaue | Quick Enry - VOM S These figures will be used when
vou — (3 X @ & [ Addtocrder setting up the info in Encompass

Totals  1,050,000.00

Additional Credit Rec

Alternate Name | Primaiy Residence 4017 Maple St., Ventura, CA 93003 - Set up the dropdowns as Shown:

Investment Property 295 Redwood Ave., Ventura, CA 93003

Property s Address

= Property is used as Investment
Property Status is "R” for Rental

|| Address | 295 Redwood Ave [ subject Property
City 'Ventura ' Property is used as
State CA Zip 93003

a. Purchase Price

c. Land

| Select the Type of Propert
" d. Refinance - Morigage Balance @ 0.00 yp p . y .
e. Estimated prepaid i Present Market Value | 500,000.00  Morigage Payment 3 0.00 - Eﬂsure th(]'t C]ﬁy mortgqge ||eﬂ 1S

f. Estimated closing ¢

g. PAI, MP, Funding Fee :m'":"“:;s"’sm % fm’ R‘"':x::m —_7“73'0:] to the REQO via the Atta Chl
h. Discount (f Borrower {| '7P¢ °f Prope B Toue b, Bpence ~ _316|

i. Total Costs ( a throug| Purchase Price — Percentage of fenta N_EVER IOCk t h i S ! !

Date Acquired " Participation %

«7>< 7 - Input the Present Market Value

- Input the figures from the 1084
Worksheet (see next slide)

Comments FREE & CLEAR

nations
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1003 - Page 3 - Setting up Investment Properties in the
REO:
— (Note, this particular property is Free & Clear)

— The numbers from the 1084 go directly into Encompass
The system will calculate to

Subject Address: 295 Redwood

o et 1000 et match the 1084, SO S371 will
Gross Rents Received (Line 3) $4,000 $20,700 reflect Occurqtely |n

Total Expenses (Line 20) - (513,479) - (514,553)

Insurance (Line 9) + + $674 EncompOSS Ond When

Mortgage Interest (Line 12) S0

Taxes (Line 16) + A $3,107 AU S |S r U n

Depreciation (Line 18) + ) v $6,371
Amortization/Casualty Loss/One Time Expense (see comment) + S0

HOA Dues + S0 ** You Wi" Only be
O S  vorgageaace - inputting Taxes/Ins/Exp

24 Month Avg $687 Monthly PITIA Payment . — W ‘ if the prOPerty iS F&C OI"
Total Qualifying Income or Loss = . °
auaty M if these are NOT included
Texes, s, Expenses in the mortgage payment

Percentage of Rental

Participation %
Net Income / Loss )

L
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1003 - Page 3 - Setting up Investment Properties in the REO:

Another Example:

— You will notice that the $1179 is already accounted for since the mortgage lien is properly attached to the

REO
The processor noted that the escrows are included

The system correctly calculates the true gain/loss to match
the 1084 worksheet

Tax Return - 1040 Schedule E 2014

Gross Rents Received (Line 3) $10,900 $5,650
Total Expenses (Line 20) - ($9,622) - ($13,562)
Insurance (Line 9) $1,155 $1,787
Mortgage Interest (Line 12) $2,473 $5,635
Taxes (Line 16) $3,640 $3,398
Depreciation (Line 18) $2,654 $2,654
Amortization/Casualty Loss/One Time Expense (see comment) S0 S0
HOA Dues S0 S0

$11,200

N o+ + + + + +
N o+ + + + + +

Total Annual Gross Income

12 Month Avg $464 Adjusted Gross Income/Loss $464
24 Month Avg $698 Monthly PITIA Payment - $1,179

Total Qualifying Income or Loss i’

Address [ 1925 E 21st St | [ subject Property
Sty Mission | Property is used as
State  [TX zip 78572 |

Afttach/Show Liens Mortgage Balance
resent Market Value ' \{5,000.00 I Mortgage Payment

—

roperty Status (SPS,R) | R o |/ Gross Rental income
Iype of Property ISnye Famly ¢ Taxes, Ins, Expen
Jurchase Price ' |

Jate Acquired Participation %

Net income / Loss

V4
Ihvestment Property |Z|

L
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Additional Requests Information Screen: |« w s
sditona Recuests nformaion ————— [

Blue Fields are REQUIRED fields L e

— for this screen, required when finishing the Resubmittal
Milestone

The Closing Team will require a Fax# or Email Address for

executing mtgee correspondence PO P ————

e |To(Hazammanoecompmy):
—_— , Company |Sagesure Insurance Manag (1  Contact | Dwight W Andrus
If the agency does not utilize a fax# { 2 | }
. . Address | PO Box 12999 Phone 337-981-7300
input all ZEROs and supply an email o ratshessee e [swseimw
address (input under Tools » >~ . - -
" Replacement Value I Insurance Escrowed? Yes [ | No

File Contacts, see next slide) uwimmpedocits || %ors| ]

Comments

L
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Tools Tab > File Contacts - for inputting HOI email contact:

|8 Funding 121316 41  Builder

(] Shipping 1214186 42  Hazard Insurance Sagesure Insurance Managers Dwight W Andrus 337-981-7300 skd@andrus.com
] Purchased 122816 43  Mortgage Insurance

(=] Reconciled 1212916 44  Surveyor

Completion 010217 NE 45  Flood Insurance Selective Insurance Company

Tools } Hazard Insurance

Forms

File Contacts

Business Contacts
Conversation Log

TPO Information
Correspondent Loan Status
Tasks

AUS Tracking

Disclosure Tracking

nations
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AAA/Refinance Qualification Form & Purchase Qualification
Form
— Primarily completed by the LO during the application-taking process

— Contains links to the screens that should be completed by the LO

— Processing can utilize the FHA Summary link to request the FHA

Case# assignment via Encompass (see Tutorial on how to pull @
case# via Encompass)

NLC Application

2010 lemization 2015 iemization

2010 GFE LE Page 1

REGZ - TiL RegZ - LE

X0 TR

State Disclosures

L
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AAA/Refinance Qualification Form & Purchase Qualification
Form

Forms  Tools  Services » consumer credit report by [Sarah McKinney ‘

1098 Mortgage Interest
2015 temization Credit Authorization confirmed by | Neal Ferguson Doherty

AAARefinance Qualification Form - - = — = . -
A dditional Disclosures Information Credit Information | Order Credit “ Import Llabclmes“ View Credit | lUndlsdosed Manage VOL |

Additional Reguests Information Borrower Co-Borrower

—

— Also available from this screen is the link to complete the UDD
form PRIOR to initial disclosures being sent to the borrower(s)

— This way it comes back ALREADY COMPLETEDI
— Simply click the Und Debt button S e i

Undisclosed Debt Credit Inquiries

and complete the fields e [

*k . . . . S
All common inquiries on a given ™™ ===

Type ofinqury: | ortgage maury v]
date can be input on the same line  wmeea  fwmwmens

Total Obligations: | " 45000]  Monthly Payment: |
Type of Inquiry: | Other (Revolving - Store Credt Card

L
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ATR/QM Management Screen:

_Q u g I ifi C_ati Q n Ta_b: BasicInfo =~ Qualification  ATR/QM Eligibiity ~ Non-Standa

— Here, you can confirm
Points & Fees compliance e e i s et o

Current Qualified Mortgage Fee Threshold &S 4,430.24 3.000 %
Total points and fees applicable under section 32 ) S 1,390.00 0941 %

The result of Points & Fees Test: Thisloan  does/ v does not exceed the threshold for Qualified Mortgages

ATR/QM Eligibility Tab: I

Basic Info  Qualificaton =~ ATR/QM Eligibiity  Non-Standard to Standard Refi  Appendix Q

— Here, you can confirm Ability e
to Repay (ATR) and Qualified ==, ——

Is Loan Eligible for Safe Harbor? 3) I

Mortgage (QM) status —

« Meets ATR/OM Standard v
¥ Does not meet ATR/OM General General Agency/GSE Small Creditor
¥ Needs to be reviewed Ability-to-Repay  Qualified Morigage Qualified Morigage  Qualified Morigage

Loan Term 4
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Borrower Summary - Origination Screen:

— Ensure accuracy of the subject property address; generally per USPS,
as the standard. If USPS not available, search county records.

Subject Property Information Copy from Present Order Appraisal Order Flood Order Title

Address 2925 SE FARLEY RD Property Type | Dctached v
City Port Saint Lucie Estimated Value | 275,000 |
State FL Zip 34952-5819 Appraised Value 240,000

— Be sure to select the appropriate Property Type

— Estimated Value should be the amount that the borrower believes
the home to be worth. This should be input by the LO during the
taking of the application.

— Appraised Value comes from the appraisal and will typically not
coincide with the Estimated Value.

nations
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Borrower Summary - Origination Screen:

— Ensure that the CREDIT REFERENCE# matches the credit
report associated to the file

TransUnion / Empirica 762 TransUnion / Empisica 754 If the file requires SEPARATE credit
reports per agency guidelines
(unmarried), only the Borrower
report# will appear

Equifax / BEACON 791 Equifax / BEACON 789
Minimum Required FICO 620 Minimum Required FICO 620

Credit Score for Decision Making Credit Reference # 35701027

Size  Current Version
929 KB

You should only have
ONE report per - o 35701027 FNMA #
borrower/borrower NATIONS LENDING CORP
pair = CUST. # 100886
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Borrower Summary - Origination Screen:
Investment Property - Input for Rental Gain/Loss:

— Purchase File - New Investment Property
* Input the Gross Rent per Lease Property Wil Be

 Input the Occupancy Rate of /5% commmsary Gross 350000

¥ Investment Occup Rate 75.00 | %

— The system will calculate the gain/loss by taking the
Gross Rent X 0.75 - Proposed PITI Mot Housing xpenses

Present Proposed

* You will see the gain/loss on the Transmittal Summary 7 \% 73

+ In this case, (3500 x 0.75) - $2215.31 = $409 .69 o —

|
RE Taxes | | @ 78468
[

« ** SEE NEXT SLIDE Mg, ns | #a

HOA Dues 37.50
other | | &

Total 1.00 221531
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Borrower Summary - Origination Screen:
— In this case, there is a (+) Cash Flow for the Subject Propert

nazaina msurance

ower Co-Borrower Total
Base Income 2,500.00 2500.00 Taxes
Other Inc 1,102.00 1,102.00 Mtg. Insurance
HO A Fees

(+)CashFiw (&  409.69 40969  Other

S Set
Total Income 401169 To

Other ations

&

L
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Borrower Summary - Origination Screen:
Investment Property - Input for Rental Gain/Loss:

— Refinance File - Seasoned Rental Property = Subject of the

Loan
* Calculate the Subject Property Gain/Loss based on most recent tax
return(s) depending on product/AUS findings. Use the 1084 worksheet.
RENTAL INCOME (need 1040 and Schedule E) Complete only if required by DU Findings

* From the 1084 worksheet:
(only one year of tax returns e )

2010 Line 22 / 2011, 2012 & 2013 Line 21 (Sch E)

We re re q u | re d p e r AU S) ' Depre;)alt;o: 20/2011, 2012 & 2013 Li 1
ine . Line 18 (Sch E)

2,500.00

+ Insurance (Line 9 of Schedule E)

$
*% - + Mortgage Interest (Line 12 of Schedule E) S 22,674.00
see hext slide T B el B _—
+ HOA Dues ( if appl) S -

2010 Line 18 / 2011, 2012, 2013 Line 19 (Sch E)
Gross Rental Income| S 84,985.00
Monthly Gross Re
Less PITIA Payment (enter as a negative

24 Month Average| S 6,013.67

L
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Borrower Summary - Origination Screen:

— Input the amount calculated from the 1084 Worksheet into the Gross
Rnt field on the Borrower summary - Orig; property Wil e

— Inputting an Occup Rate of 100% will allow Secondary  Gross Rt I;Jm
the system to count the calculated amount ,, |

Amortization Type

— Once again, the system will calculate the (+/-) cash flow by

subtracting the proposed PITI from the Gross Rnt amount and this
will appear on the Transmittal

Base Income Taxes

S umrma ry Forms  Tools  Services ,|| Other income 3,861.38 3,861.33  Mig. Insurance

HO A Fees

433.15

State-Specific Disclosure Information A | | .
Transmittal Summary (+)CashFiw [3] 3,445.76 O R - Other
ULDDPDD Co-Mort Set 5,271.81 527181 t
Underwriting Submission Form
Underwriting Worksheet

Total Income 12,578.95 12,578.95  Total Prim Exp

Other Obligations
USDA Management Qualifying Ratios

VA 26-0286 Loan Summary (-) Cash Fiw @
VA 26-1805 Reasonable Value Top (Primary Housing Expense / Income) 45194 %  Co-Mort Set

L

nations
lending




Borrower Summary - Origination Screen:

— It you are doing a REFINANCE and subordinating a FIXED 2nd
mortgage, you would input that here:  suwernaevotgage Lo anauns

Ist Motgage | 275,025.00|
Loan Type Lien Position 2nd Mortgage | p.00|

Affilisted Business Disclosure
Aggregate Escrow Account

ATRIQM Management Conv ¥! First Addtional | 0.00|

Bi-weekly Loan Payment Summary ¥ FHA UK
Borrower Information - Vesting VA | Sub. Financing | Cancel
Borrower Summary - Origination USDA-RHS

Borrower Summary - Processing Other -

*“***NOTE: the system will “assume” new financing and place the
amount being subordinated on 1003-page 3, line j. Be sure to
remove this figure from line j.

VIl Details of Transaction

a. Purchase Price
‘ b. Alterations

nations
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The CD/Loan Closing Request Form:

1) Input Target Closing Date

2) Loan must be LOCKED & Cond Approved
3) ** AllFEE-RELATED items must be accurate

CD Reqguest Function:

CD/Loan Closing Request Form

Branch:  [3154 Miramar FL: Nina I3 Est. Closing Date | 1172872018 | )

4) Make any additional notes, for
example, if a POA is being used

5) Select CD Delivery Method

B) Select whether or not LO wishes to review
prior to delivery

7) If afinal LE must be sent for any COC,
checkmark the Generate Final LE box

8) Checkmark the Generate CD Request box
9) Save the file

|

CD Requirement *Please submit your CD Request here*
+ Rate Locked PLEASE NOTE:
+ Conditional Approval
+ Pay off (refi only)

+ ALTA 1/Prelm CO If you need a rush request, please
+ Updaled Tax Cert n r nationslending.com

+ HOI Policy
+ Morigage Insurance
+ Title Commitment to determine who needs to recieve CD

CD requests are sent 24-48 hours from the time requested.

NOTES:

[ Return fie to LO & Processor  Assigned CD Analyst | Susan Kondrabich

[ Generate Final LE Generate CD Request  §1/06/2018 05:10 AM

L

nations
lending




The CD/Loan Closing Request Form:
The person responsible for completing the Loan Closing Request would need to
complete the ENTIRE bottom portion of this page

The “Check the Box to Generate...” should NOT be check-marked until the loan is
CLEARED TO CLOSE

” Be sure to input an accurate Requested Closing Time to properly alert the Funding

Team of when to anticipate DOCS

Information for NLC Closing Department and Settlement Agent

Requested Closing Date: _1 2/14/2016 NLC Representative CellPhone # for Notary: __330_233 3303
ing Time: Who should the notary contact to confirm? l—':l
Bi-weekly Loan Payment Summary I ry Borrower W

Bo Information - Yesti ) ; 2 e - . . | 490 SUNSET DR HALLENDA
Frower information ° |rTg Instructions To Closing Department Closing Location: Iomer V| If "Other” enter Closing Address: "4
Borrower Summary - Origination

Borrower Summary - Processing By Checking The Following Boxes | Acknowledge The File Information Is Correct

CDA.0an Closing Request Form Al Settiement Charges and Third Party Fees to be collected are listed on the Remization
Channel Manager Checklist
Closing Disclosure Page 1
Closing Disclosure Page 2
Closing Disclosure Page 3

MMacin~ Nierlaci wa Dana 4

I have reviewed the terms of the loan in detaid with my borrower to ensure a smooth closing

CHECK THE BOX TO GENERATE CLOSING REQUEST

nations
lending




DocuSign Disclosure Request Screen
What to look for..

You want to
see the
borrower’s
name,
followed by
“Completed”
or
“Sent”

DocuSign Disclosure Request

" Loan Estimate
Nations Disclosure- Cover Letter- Rate Lock
Nations Lock Agreement

Notice of Change Circumstance Reasons

CA Commitment Agreement
CA Credit Score Disclosure
CA Disclosure Receipt

CA Machine Copies Nofice

CA Notice to Home Loan Applicant

Nations Disclosure- Conditional Commitment

CA Rate Lock Agreement
Loan Estimate

Nations Disclosure- Cover Letter- Rate Lock

CA Additional Per Diem Interest Charge Disclo...

CA Notice of Right to a Copy of the Automated...

Nations Disclosure- Cover Letter- Conditional...

03/24/2017 15:44

03/24/2017 15:44

03/24/2017 15:44

03/17/2017 10:27

03/17/2017 10:27

03/17/2017 10:27

03/17/2017 10:27

03/17/2017 10:27

03/17/2017 10:27

03/17/2017 10:27

03/17/2017 10:27

03/17/2017 10:27

03/14/2017 07:33

03/14/2017 07:33

03/14/2017 07:33

Nicholas Apostolakis - Completed | Teresa Shanks - Completed
Nicholas Apostolakis - Completed | Teresa Shanks - Completed
Nicholas Apostolakis - Completed | Teresa Shanks - Completed

Delivered to DocuSign Queue Service
Delivered to DocuSign Queue Service
Delivered to DocuSign Queue Service
Delivered to DocuSign Queue Service
Delivered to DocuSign Queue Service
Delivered to DocuSign Queue Service
Delivered to DocuSign Queue Service
Delivered to DocuSign Queue Service

Delivered to DocuSign Queue Service

Nicholas Apostolakis - Completed | Teresa Shanks - Sent
Nicholas Apostolakis - Completed | Teresa Shanks - Sent
Nicholas Apostolakis - Completed | Teresa Shanks - Sent

03/22/2017 08:37
03/22/2017 08:37

03/22/2017 08:37

If you see
nothing
here,
contact the
Disclosure

Team

03/14/2017 05:08
03/14/2017 05:08

03/14/2017 05:08

nations
lending




FHA Management Screen:

Basic Info Tab:
— Ensure that Property Type and Purpose of Loan are
completead:

Purpose of Loan
Purchase

No Cash-Out Refinance
Property Type
~ Cash-Out Refinance

VI tunt []2unts []3-4units [] simpie Refinance (FHA to FHA)

D Condominium D Co-Operative [] Streamiine Refinance (w/ appraisal)
__| Manufactured Housing ] Streamiine Refinance (wi/o appraisal)
Construction

Tracking Tab: conatracton - porm
— Input Date Pulled & FHA Case# inc_:luding ADP CODE

Basic Info  Prequalificaton =~ FHA 203k = Tracking

' FHA Case Number | Obtain | CheckHoidings | View Findings |

Date  |06/22/2016 |2 Case Number | 244-1246644-703 ]

. | L7
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FHA Management Screen:

Tracking Tab (cont):

— For FHA to FHA Refinances, input the Refi Auth Data per
FHA Connection

— Input CAIVRS# for borrower(s)

Refi Authorization

Date  |If A Oid FHA Case #

By MIP Refund
Prior Endorsement Date  //

I Borrower CAVRS # | A174337283
| Co-Borrower CAIVRS #




FHA Purchase Calc Screen:

— Line #103 is the total of Line
ltems e, T, g, & h (if applicable) .

. . Line 103 Total Closing Costs 9,091.40 Purchase Price

from the Details of Transaction e 502 Uriap 219988 3.5% Roqurement
[ e [Estimated prepaid tems ) 1,841.67 Total CC excluding UFMIP (line A)

f.[Estimated closing costs ) 4908.10
g{ PN, MIP, Funding Fee . 219368 Sellr Paid Closing Costs (ine B) | 4,000.00
1 h| Discount (if Borrower will pay) ) 147.95 Lender Credits (ine C) 25.00 |

— Line B comes from Line Item k, Total Credits (Lines B & C) Cannot Exceed Max Tax Pro-Ration Credit 4,350.67

. Total Closing Costs excluding UFMIP (Line A)  Tax pro-Ration Amount
which populates from the (Cannot exceed Max

. . . Closing Costs Unpaid Tax Pro-Ration Credit)
2015 ltemization — Seller Paid o

Closing Costs column Line 303 Cash to Close TotalInvestment

Does the borrower meet
Total after fees i . —
investment of 3.5% _

(Yes/No)

Verified Assets 12,273.31
Line 303 Cash to Close 792264

j. Subordinate financing [ 0.00 Brw's Current Investment

@;c paid by seller . 400000
L l Cash Deposit on sales ¢ vl [ 500.00 |

nations
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FHA Purchase Calc Screen: Closing Costs Unpaid 2mn

. . g . EMD 500.00 |
— Closing Costs Unpaid is Line A s e e s —
minus Lines B & C o  ssa92)

— The EMD is the cash deposit on
the sales contract

Brw’s Current Investment 5,549.92

— Line # 303 comes from ltem p in the DOT

ash from / to Borrower  [3] 792264

— The Total after fees is calculated by taking the Closing Costs
Unpaid, MINUS the EMD (since this is a credit), MINUS the Cash to
Close, giving us the Borrower’s Current Investment of $5549.92:

« (S2872.72 - $500) - $7922.64 = (-55549.92)

20
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Purchase Price 129,900.00

FHA Purchase Calc Screen: s requonent | 454650]

— Verified Assets will populate based on S s
the Total Bank Deposits listed on 1003-p2 Line 03 CashtoCose 792264

— Max allowable tax pro-ration credit will be MaxTaxproRaton Creat 435067
Tax Pro-Ration Amount -1,002.24

the amount of verified assets MINUS the (Comot eceed o
cash to close (since we must show sufficient

Does the borrower meet

funds coverage to apply the proration) S e
— Actual Tax Pro-Ration Amount should come  mamaiss e

(Yes/No)

from the CD provided by the title agent

— Total Investment equals “Current Investment” ($5549.92)
MINUS the Tax Pro-Ration = $S4547.68

*** This amount MUST exceed the 3.5% Requirement ***

20 o,
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FHA Purchase Calc Screen:

— NOTE - this calculation screen will now be located on the
Quality Assurance Review Page 2 Form

— NOTE - this screen will also be available on the Purchase
Qualification Form

Forms  Tools Services

Purchase Qualification Form

QC Status Update

Quality Assurance Review Pg 1
Qualty Assurance Review Pg 2

L
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FHA Summary:

Borrower Certification

22a. Do you own / sold other real estate? IYes v I

Is it to be sold? INo v|

22b. Sale Price [
22c. Original Mig Amount |

T — | - Adjustments can be made on this

Street |

e ’[— > | to revise/correct the information

21 Dy e e o o et [ 2 appearing on the HUD-92900-A

25. |, the Undersigned Borrower(s) Certify that:
(2) Occupancy:
Il now actually occupy the above property as my home

(3) I have been informed that $ 289,000 is

|l was not aware of this valuation when I signed my contract
(6) For HUD Only - | have received information on lead paint poisoning |Yes |V

L

nations
lending




FNMA Streamlined 1003:

— On CONV loan types, you would input a Repayment Type Code of “No
Negative Amortization” to avoid a Warning on the DU Early Check report

IV WAT VAR T BT R WO TR SRS R {

Repayment Type Code
Loan Documentation Type Code %’M e

- Interest Only
("] Seller Provided Below Market| Posaiiie Hagalive - ation ] Es

ARM Index Type l— Scheduled Negative Amortization

— On a REFINANCE where you are subordinating a HELOC 2nd, you would
input the HELOC Actual Balance and the HELOC Credit Limit here:

FL Lender Disclosure Qual Rate . 3.500|% Signature Date |/ @@ HCLTV/HTLTV| %

FNMA Streamlined 1003 HELOC Actual Balance ] HELOC Credit Limit }
Freddie Mac Addtional Data :

HMDA, Information MORNETPlus Community Lending

L
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FNMA Streamlined 1003:

— If you are doing a ENMA Home Ready product, you would note that
here:

MORNETPIlus Community Lending

‘ B [ ramstagiborsEighie [ Gommnily Soconds
Metropolitan Statistical Area or County [

Fannie Mae's Community Lending Product | 08 Home Ready E

HUD Median Income [

income Limit Adjustment Factor [ |%
- o | I

— The CAIVRS can also be input on this screen:

Borrower's CAIVRS # Co-Borrower's CAIVRS #

— On VA loan files, this is where you would notate if Borrower & CB are

mMarried: VA Loan Data |:>

Borrower Spouse
Federal Income Tax ] [ ] Zﬁmwerlco-smowermmnied

nations
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Freddie Mac Additional Data Screen: — ™ [we s

FNMA Streamlined 1003 A

Input data on this screen PRIOR to oA momm

runmng files through LP to avoid rmssmg data errors.

Complete all applicable fields:

Processing Point Iﬁuuicaﬁonﬁ*ocessho

Secondary Finance | No secondary financing v
ReqdDocType  |Full documentation

Purpose of Loan |Purchase

Property Type | Single Family Detached PUD
Buikding Status | Existing

New Construction Type |
Condo Develop Name | SUMMER SANDS
Condo Class |

Mortgage Insurance Information

Mi Refundable Option | Mi Coverage I

[ Renewal Option |
Payment Option | Payment Frequency |
Years of Coverage |

Renewal Type

<l <l [<] <]

Premium Source |

<]

nations
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Freddie Mac Additional Data Screen:

f you are doing a Freddie Home Possible or Home

Possible Advantage loan, you would designate that
oroduct offering here:

Freddie Mac Defined Data

Loss Coverage Est. # | v
Lender Registration # #2

Freddie Field #3
B oo e
No-Appraisal MAF # | v

Rrakar Nrininatad 8 [

L
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HUD 1003 Addendum:

On FHA loan files, your Branch Lender ID# will be listed here:

Forms  Tools Services R Term of Mor

Home Counseling Providers )

T 13. Lender 1.D. Code | 2377300000 |

HUD-56001 Property Improvement 14. Sponsor |.D. Code X |

This is a screen where you can I
also make corrections, if needed, o b st [ T

Is it to be sold? v

to the FHA 92300A/VA 26-1802 e ot |

|

l
22d. Address of the Sold Property
form: sveet | |
cty | |

State Zip

22e. If the dwelling to be covered by? o [~]
22f. Do you own more than four dwelings? |No
23. Have you ever had a VA home loan? I_E

25. |, the Undersigned Borrower(s) Certify that:
(2) Occupancy:

L
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HUD-92900LT FHA Loan Transmittal:

If you are processing an FHA Purchase using GIFT FUNDS, you
MUST input the information on this screen so that AUS
recognizes the use of GIFT FUNDS.

Forms  Tools Services

** You mqy receive Approve/ E|i9ib|e Home Counseling Providers A | Gifts [] sefler Funded DAP
findings if the data is NOT input here, D oo Acenau 1. Source /EM |

HUD-56001 Property Improvement [:] ] e

then end up with REFER findings HUD-928005b Conditional Commitment

HUD-82900LT FHA Loan Transmital (] other

(requiring MANUAL UNDERWRITE) Income Calculation Worksheet Amount of Gift

once in put. ftemization Cc:mpletion Guide 2. Source /EIN |
Loan Compatison Chart [] Govt D NP

Loan Contacts
. [_] other
Loan Estimate Page 1

*% .
Be sure to check this!! Loan Extinate Page 2 Amount of Gift

Faniy
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HUD-92900LT FHA Loan Transmittal:
f you are processing an FHA Purchase using GIFT FUNDS, you

MUST also input this information so that AUS recognizes the use
of GIFT FUNDS.

HUD 1003 Addendum # O7T MOonms In KeEServes l J CHUMS |D*Iu“A

HUD-56001 Property Improvement Total Seller Contribution
HUD-928005h Conditional Commitment Seller Contribution @ %

HUD-92900LT FHA Loan Transmittal Source of Funds FHA - Gift - Source Relative
Income Calculation Worksheet

Loan Comparizon Chart Underwriter Comments
Loan Contacts
Loan Estimate Page 1

—— B B PR

L
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Income Calculation Worksheet:

This form is used to show your calculation for Hourly/Salaried
Borrowers. There is a Borrower & a Co-Borrower Tab.

— 1) Select the Pay Type —

Borrower Coborrower ,

- 2) | n p U t d Otg fro m Bomower Income Calculation Worksheet Date Filed Out 071052016 12:52 PM

DO y St u b S 8 \/\/ —_ 2 S Employer | Stephens County Hospital Total Income to Qualify

— 3) Checkmark additional SR

126,838.44 | YTD Eamings 00| Number of Months

boxes to open up sections T e werrocres: [ 9] | w| sembwrhons

76,065.007 W2 For Tax Year: |2014 v 1200 | Number of Months

for Overtime/Bonus/Commission o e e

6,709.61 YTD Average Please check the box next U Break Out Commission
i Other Income
662178 YID*1 Year W2 Average %o the oddilional fypes of

— *NOTE: clickingon anoption =~ =i wioiizl S B
button will NOT populatethe =~ 1] e O T

amount to 1003-page 2; the income figure being utilized must be
manually input

nations
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Income Calculation Worksheet:
— Example one of the additional income screens:

Overtime / Bonus

\ ‘ YTD Overtime / Bonus® I: Number of Months
\_ | Past Year OT Breakout Number of Months
| | Additional Year OT / Bonus || Numberof Months

YTD Average * If DU requires only a YID paystub, OT/Bonus must be annualized.

Divide YTD OT/Bonus by 12 months
YTD + 1 Year Average

YTD + 2 Year Average O Lowest Income

Selected Other Income You Wish to Use

** Note: UW requires some form of income calculation be provided in
the file at initial submission. This screen is a great place to do it.
Or, you can place your own income calc form in the Cover Letter

to u/w — Initial folder or notate your calculation on the Cover
Letter to u/w — Initial.

20
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Loan Contacts Screen:

" This screen was put into production on March 1st, 201/
~ Used for ALL 3@ party tracking

" Flows to a pipeline view for Ordered/Received Dates

Hazard Insurance L) Ordered: // Received:  12/12/2016
»

Forms  Tools Services
Loan Contacts Company Name ITlIon Insurance Group | Hazard Policy # IFpH 4046006 05

Loan Estimate Page 1 Address 100 N State Road 7 Unit 304 | Policy Eff. Date |

Loan Estimate Page 3 State / Zip IFI. “33063 | i = |

Loan Submission
i umbe Fax 866-65
MLDS - CA GFE Line ftem N ' D I Ll

Net Tangible Benefit Worksheet Lo Triton Insurance Group |

|
|
Loan Estimate Page 2 City Margate I 3 | 366-400-7674 |
|
|
|

Comments |

NLC Application Replacement Vabe\ I Insurance Escrowed? (V] ves [ | No
NLC Appraisal Appeal Form
NLC Appraisal Request

Notice of Incomplete Application
NY Application Log Company Name | BROWARD COUNTY SHERIFF O] VOE Ref # |
NY Preapplication Disclosure Address |7515 NW 88TH AVE I Phane = l

VOE (Borrower - Current) 1} Ordered:  // Received: /|

nations
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Loan Estimate Page 1 - Requestinga COC

Disclosure Information

Rmon4 1&]Wﬁwm

S:ﬁﬁ:ﬁ:xmm Changes Received Date | 0222012017 1) Checkmark the Changed Circumstances box.
] Revisons requested b he Consume Revised LE Due Date 0212312017 2) Click the Magnifying Glass and select the
reason, if available. If not, select "Other”.
c | 3) If "Other” is selected, place a

I.f the COC ‘ Detailed Explanation in the comments box.
MA]PI;/I(R)IlXESD?ATA 4) Checkmark a Reason, if listed. If not, select

: "Other” and copy/paste your statement
change - a.ddmg/ M3 from the comments box.
removing 1

—
bo rrowers : lo an 2lect one or more changed circumstanés below. Press Ctrl or Shift key to click and select multiple

program change, i Commerts

ditional service is necessary based on receipt of title report Addtional service is neces:
etc, be sure to ditional borrower has been added of remaved from the loan application Additional borrower has bet
a d d a hote 1n praised value is different than estimated value sunolied Appraised value is different

the
CONVERSATION
LOG

Changed Circumstance

[
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Loan Estimate Page 1 - Inputting INTENT TO PROCEED

ntent to Proceed Loan Estimate senton 10/31/2016 (2

Received Date 3 10/31/2016 | &4
Received By 2] Susan Kondratick(skondr
Received Method

4

Comments

1) Checkmark the Intent to Proceed
box

2) Click on the magnifying glass to
select the date of the Intent to

Proceed disclosure (this will match
the date of the INITIAL LE)

3) Input the date SIGNED by the
borrower

4) Input the Received Method

** If the system will not allow you to complete this screen due to a
“presumed received date” that is later than the actual received date, you
will need to input this info under Tools > Disclosure Tracking (see next slide)

A 7
19 EE:




Tools > Disclosure Tracking - Inputting Intent to Proceed
— Go to the Tools Tab > Disclosure Tracking

— Double-Click on the EARLIEST date to open up the screen on
which you will input the INTENT TO PROCEED information

Forms  Tools Services »  Disclosure History (4)

File Contacts Sent Date Method By # of
Business Cortacts 104312016 05:50:01 PM Closing Docs Ord  Tameia Cooper(tcooper) 37
Conversation Log 1042812016 Other Tameia Cooper(tcooper) 3
TPO Information 10/20/2016 Other Shian Dancy(sdancy) 2
Correspondent Loan Status | ‘ 09/22/2016 Other Nicholas Apostolakis(napost 3
ALS Tracking

Disclosure Tracking

Fee Variance Worksheet




Tools > Disclosure Tracking - Inputting Intent to Proceed

— This is the screen that will open up:

— 1) Select the ACTUAL s EE—
received date Oackoae Tpe - Borower

Sert Date a [10/31/2016 Received Method Other

[docusign

— 2) Checkmark Intent tc * 8 oo Mt | PenmedFecovd Due ) 155208
|docusion Actual Received Date  |10/31/2016 1
l

Sent Method

Proceed p— A

Date [10/31/2016 3 @v| | CoBomower

— 3) Select the date that === LT, | st
. Received Method Signature |
the borrower signed 4 s acsved D

Comments Actual Received Date

— 4) Select Received Met: v ‘
— 5) Click OK at the bottom of the screen to save the data

l

Borower Type [

L
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Nations Application Screen:

If you are WAIVING ESCROWS on a CONY file with </= 80%
LTV or a DURP/HASP file where you are eligible to waive
escrows, that would be completed here:

12724

Estmated Value
Appraised Value 1,425,000
# of Units

Property Type |Detached v

Nations Appraisel Appeasl Form Legal Description See prefminary tie report
Nations Apprassal Reguest U e
Nations go

— You would select “NO” and UNcheck the boxes for Hazard Ins
and/or Property Taxes, depending on what is being waived.

L
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NLC Appraisal Request Form:
— This screen is utilized for VA LOAN TYPES ONLY

— Whomever is responsible to complete this screen, inputs the
data and clicks Request Appraisal; the appraisal is order via
the VA Portal by the Appraisal Desk

— Tracking of the appraisal status occurs on this screen as well

““Status update section to be read only for all those other than appraisal desk**

Loan Submission Status Update

MLDS - CA GFE [ oq ! Days Since Ordered: E

Net Tangible Benefit Worksheet +|_Request Appraisal . Property Will Be
NLC Application Appraisal Type | ~v| v primary

NLC Appraisal Appeal Form Secondary
NLC Appraisal Request
Notice of Incomplete Application

Scheduled Inspection Date: |/ | £

For Purchases ONLY: (] _Appraisal Completed 10/05/2016 Sent to Borrower 10/20/2016
NY Application Log Credit Card Mailing Address: } Current Status: | v NOV/Appraisal Sent // iz
NY Preapplication Disclosure City State Zip Code |

Nedvisd 0 ~4

20 I
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Patriot Act Form:

— Data can be typed directly into this screen and then the form
can be printed and signed/dated by the LO (or this can be done
right at their desk if they have the ability via their Adobe
Acrobat version!)

i - Document 2 is REQUIRED on all

Patriot Act Information Disclosure

This disclosure information was obtained from borrower via: ITm PatriOt ACt Forms
Apptcantinformaton - The dropdown for Document 2 lists

Name of Appiicant: " R

ame ofDocunet [5rs Tcoas all possible choices

*Must be unexpired, government-issued photo ID

Identification Number: A9135072
Place of Issuance: | CA

Date of Issuance: | 07/16/2014
Expiration Date: i0512212019
Date of Birth: 05/22/1976
Document 2 (if required): |Social Security Card

L
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Processing Status:
— This is a “monitoring” screen that can be shown on your pipeline view

— Typically used to input items that are missing that keep you from moving
the file to the next milestone

— Can also be used to update Est Closing Date & 1st Payment Date
Pipeline View:

In 9]0 t Data Here : Outstanding Resubmittal Conditions Outstanding Resubmittal Conitions |
! n B

Submittal and Resubmittal 112 - need.corrected appraisal HOl HOA dues Mtg stmt 111272017 5:28:00 AM I

Oustanding Conditions for all milestones: /

1/12 - need:corrected appraisal,HOI,6 HOA dues,Mtg stmt

Forms  Tools Services

»
1st Payment Date: 03/01/2017 :
Processing Status A @
01/25/2017 |4  LastModified: Donna Stoicoiu 0

Processing Submission Form Est. Closing Date:

Property Information UW Suspended Date | 01/10/2017 | 4l

nations
lending




Processing Submission Form:

— If your branch chooses to use this (we highly recommend it!), it
would be completed by the LO

— This helps the processor know which “hat” (loan type/agency)

to put on when initiating the fi srercmmome
Best time to reach borrower: Borrower can be contacted at work:

Direct work line: |

— Also a good place to note best
time & number to reach the o |

borrower; inPUt HOA ContaCt PhoneNumbérzl MonthlyDues:iso‘oo
details; input NOTES!! ‘ ]mm C—

Append Document Set

NOTES: (Please tell us anything that will help us with the file: Income or Credit Issues? ETC.

nations
lending




Property Information Screen:

The following info should be completed on this screen:

— Flood Cert Number and Flood Zone, which comes from the Flood Certificate pulled

through FZDS. This info should auto-populate as long as the flood cert does not go into
“research” (you will get a pop-up if this happens)

B. NATIONAL FLOOD INSURANCE PROGRAM (NFIP) DATA

Property Information

Subject Property

Address  N4353 County Rd H

City Black River Falls

State wi Zip 54615
County Jackson

Flood Cert Number | 16082915320395

E. COMMENTS (Optional)

Date of Oniginal Determination: 08/29/16

First  Program Entry Date: 02/04/81
Con

# of Stories

Unincorporated Area I

]

Flood Zone | X v|

Property Type | anufacturesdousing v
r

1. NFIP Map Number or Community-Panel
Number
Community name. if not the same as "A”)

55053C0555 C

2. NFIP Map Panel Effective/Revised Date |3 LOMA/LOMR Number

09/28/12

1 Cubiimnd Nennmnvdis i o Dl b

] Subject Property is in a Rural Area
Subject Property is in a RurallUnderserved Area

ECTING BUILDING / MOBILE HOM

Service Type: Life of Loan /Census Tract

Determiation #; 16082915320395

Confirm that
data matches
appraisal

nations
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Property Information Screen:

— If the Flood Cert goes into “research”, you will receive an
EMAIL when the Flood Cert is completed

* To have the required information populate into Encompass (instead of
having to do manual input) you can go to the Services Tab > Order

Flood Cert > click

“paper” >
highlight the cert > cllck
Retrieve ' . :

nations
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Property Information Screen:

— Title Information:
« Parcel Number = confirm with Title & Tax Certification
 Title Report Date = confirm with Title Commitment

Prelim Information

Title Information

Book [
Page {
Parcel Number | 026-0314-0015
Lot {

Biock |

L
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Property Information Screen:

— Manufactured Housing Details, if applicable

* If doing a MH, be sure to complete the following info which can be
obtained from the title commitment, appraisal, or HOI dec page:

Manufactured Housing Details

Make Anchored I V]

Model Serial #

Year ’ HUD Label #
New/Used [  |V] Cert of Title #
tength | | Cert of Title Type |

Width

Manufacturer

Street

L
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Purchase Qualification Form:

— Primarily completed by the LO during the application-taking
process

— Contains links to the screens that should be completed by the
LO

— Processing can utilize the FHA Summary link to request the FHA
Case# assignment via Encompass (see Tutorial on how to pull a
case# via Encompass)

NLC Application

2010 temization 2015 emization

2010 GFE LE Page 1

REGZ - TiL




Purchase Qualification Form:

el —— el UL AT RAITE VAR T A GRS R ST W TILATUIENT VAT BT

v

Forms  Took  Services | CreditInformation | Order Credit || Import Lisbilities||  View Credit
Purchase Qualification Form A Borrower Co-Borrower

QC Status Update Experian / FICO 672 Experian / FICO 631

Qualty As=uranre Review Prs 1

— Also available from this screen is the link to complete the UDD form
PRIOR to initial disclosures being sent to the borrower(s)

— This way it comes back ALREADY COMPLETED!!

Quick Entry - Undisclosed Debt Credit Inquiries

— Simply click the Und Debt button ——

Inquiring Creditor: | 1/10/17 Bank of America, Na!

and complete the fields rowomcrses flo—

Total Obligations: | Monthly Payment |
Type of Inquiry: | Mortgage inquiry

** All common inquiries on a given R
date can be input on the same line oo ==

Total Oblgations: 45000  Monthly Payment: |
Type of Inquiry: [omer(Revowhg-swecredim v

L
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RegZ - CD/RegZ LE:

— This is where you would want to track Current APR versus Disclosed APR
to ensure you are within tolerance, not >/= +0.125 difference

Disclosure Information

Last LE Sent Date 09/10/2016 Current APR ) 4542
By L Disclosed APR ) 4542

— This is also a good location to confirm that the 1st payment date is in line

with the Est Closing Date  rm  wos  seess | ArexTyve |

Re-Evaluation Form A Construction Mortgage
RegZ - CD

it change A | st Comngome (11202016 3

Request for Copy of Tax Return (Classic) Est. Interest On I First Payment Date 01/01/2017 m
Request for Transcript of Tax (Classic) o=

— NOTE!! The system will NOT update the First Payment Date if
the Est Closing Date moves into the next month (this must be
done manually)

Mumhar af Nauve I v l Final Davmant Nata

L
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Request for Transcript of Tax (Classic):

— This is where you can make revisions/corrections
if an updated IRS 4506-T form is needed el NI

— If ordering via DataVerify, Line#5 should read the 'DBA address for
Datave N fy Qme transcript or tax information is to be maied to a third party (such as a mortgage

ompany), enter the third party’s name, address, and telephone number. The IRS has no
control over what the third party does with the tax information.

Name | Nations Lending Corporation ISAOA
Name (con') | C/O DataVerify 8 Parkway Center
Phone | 877-816-1220

Address | 875 GREENTREE RD.

City PUTTSBURGH State | Zip [15220

— If order via IRS Direct, Line#5 should read the Corporate Office address:

Q the transcript or tax information is to be mailed to a third party (such as a morigage
ompany), enter the third party’s name, address, and telephone number. The IRS has no

control over what the third party does with the tax information.

** The Encompass team sets this ame [Hsons Lendng Corpraton

Name (con') |ISAOA

Up fOl' eaCh bl'anCh o Phone |877-816-1220
A.ddress | 4 Summit Park Drive, Suite 200 . ' E\\J

City ’ Independence State  OH Zip | 44131 nations

lending




Risk Assessment:

— If this is being requested by sales or processing, this will likely
be related to extenuating circumstances, NLC Overlays, or
other unique situations for which you would like an exception
prior to submission to underwriting.

— If the loan is in underwriting and sk Commiee Review Requess

‘ Reason for Request:

an exception is required, the u/w e
will request the exception through st tomen

Trailing Documents

his/her manager or Credit Risk, .

Income Review - CAN ONLY BE REQUESTED BY MANAGEMENT

depending on the situation and 3 Secon v Ruese
what type of exception is needed.




Risk
Assessment:

ECI A Aerts 8 Messoges  Log

B Underwriting Farnie Mae DUy~ 1007118 A
B Loan Estimate expired 110416

W Loan Estimate expred 110418

B Ttle Report expired 11aone

W Lock confirmed by Nick Roth 1129186

N Closing Date Vickation 16016

Reason for Request:

| ] {—

Request loan to be reviewed by Risk Committee?

uwow-wmlm
W Privacy Pobcy expres 1 3 L] e e

B FHA nformed Consumer Chok 120416
W FHA nformed Consumer Choik 120418
B RS 45087 - Request for Trans 120416
W Privacy Policy expres 1204116
W Lock expres 120516
B Tax Returns - Personsl -WRh® 120518
B eConsent Rejected - Wane Be 1000416

onsert Accected -Wene B 100416 ¥ |
Real Extate Profie Condo

Real Estate Profie SFR
Re.Evaluation Form

RegZ - CO

RegZ - LE

Request for Copy of Tax Return (Classic)
Request for Transcript of Tax (Classic)
RESPA Servicing Disclosure

Risk Assessment

Rush Request Form

Sales Submission Form
Section 32 HOEPA

Section 35 HPML

el Pl cnd b m BN

Name of who requested the review
(] Second Review Requested

Name of who requested the review

Traling Docs ETA "

(] Tra#ing Docs Uploaded

Reason for Exception and Compensating Factors Required:

A

Fill in this area
with your
request
explanation.
Be sure to
include
compensating
factors!!

nations
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Rush Request Form:
The RULES:

— File must be Cond Approved (NOT in a Suspended u/w status)

— File must be ready for Final Approval review (Resubmittal
Milestone being completed)

— CD must be sent

— Select the reason and explain
— Checkmark the confirmation box

— Rush will be
Approved/Denied
by UW Mgmt

Forms Tools Services Rush Level being requested

Request for Copy of Tax Return (Classic)
Request for Transcript of Tax (Classic)

Self-Employed Income 1084

Settlemenrt Service Provider List

SimpleNexus

Statement of Denial [_] Confirm the above information is accurate,

State-Specific Disclosure Information final approval submission, and file is qualified for a Rus ]
Transmittal Summary

4] Show in Alpha Order [4] Show Al Person Requesting Rush

nations
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State Specific Disclosure Information:

— TEXAS:

== Tunucu Ur/oy/ e
# [ Shipping finished 071216
+ W] Completion 07/2916

| Purchased finished 09/08/16
# | Reconciled finished 09/08/16

Forms  Tools Services

State-Specific Disclosure Information
Transmittal Summary

ULDD/PDD

Title Information

Property is borrower’s homestead

D Continuous Purchase Money Loan

e of Relationship

We will submit your loan
[ ] we are acting as an independent c

If the Subject of the loan is
the borrower’s Primary
Residence, this box should

be check-marked

If the original purchase loan is being refinanced
with NO cash-out, a Rate&Term loan, then this
box should be check-marked. The 3% fee cap does
not apply on Rate&Term loans.

nations
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Transmittal Summary - 1008:

This is the best screen to utilize when comparing
Encompass and AUS findings when there is a discrepancy.

Proposed Monthly Payments
Borrower's Primary Residence

Stable Monthly Income Use this screen to e

Borrower Co-Borrower Total
First Mig. P &1 1,331.71

Bascincome 322920 322920 compare the data S
Other Income 5712.81 5,712.81 to t h e AU S S u m m a ry. Hazard Insurance 313.18

I Taxes 321.94

() Cashw This will generally e

HO A Fees

| — point you to the area =

' Total Income 8,942.01 Co-Mort Set

of discrepancy. B

Other Obligations

Qualifying Ratios
{-) Cash Fiw @
Top (Primary Housing Expense / Income) Co-Mort Set

Bottom (Total Obligations / Income) All Other Paymts (5
Total Paymts

L
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Underwriting Appeal Request Form:

Location: SharePoint >

workflow Process ‘ Nations Lending Processing >

UW Appeals Process via Encompass

Loan Info

Forms  Tools Services

Loan #
State-Specific Disclosure Information

Transntl Summery Csuttect of Appeal I
ULDD/PDD Collateral

Underwriting Appeal Request Form - Appraisal Value
Underwriting Submission Form Credit

Request Appeal in

Assets
Deferred Maintenance
Other

User Requesting Appeal:

Underwriting Worksheet

L
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Underwriting Submission Form:
This form is used to perform 4 separate functions

Underwriting Submission Form

Loan Type: Conventional Pre-Review Requested | // _ Fu nCtlon

Loan Program _ FNMA Conforming 30 Yr Fixed Plus e [ # 1
o
Es| F t #2 Purchase Appraisal UW Review
u nc:?;rm;m_ﬁD
Review Request Date:
Suspense Conditions to UW for Review

Function #3 o Sepondod . [7 F :
(] Condo Review Request _| un#czlon

Review Request Date:

HFA/MCC: Is there a DPA/HFA/MCC program being used? I .

Indicate Program: I

L
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Underwriting Submission Form: pre-Reviw Requested [1 |73

— Function #1 - Pre-Review Requested: ™™ '

 This is utilized for those instances where you have a file “almost” ready
to go back in for Final Approval review, but you are missing an item or

two that will take a few days to get back. You can send the file in to get
the majority of the conditions reviewed to clear.

 Input today’s date (the date you are sending the file in)
* In the Comments box, note the items missing & expected date of receipt

 Finish the Resubmittal Milestone to send the file back to the original u/
W

— The u/w will review the items to clear/reject & return the file to you. Once you

have the remaining item(s), you will once again Finish the Resubmittal milestone to
the u/w

nations
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Underwriting Submission Form:

— Function #2 - Purchase Appraisal UW Review

 This function is used to have the APPRAISAL (only) reviewed once it is
received on a Conditionally Approved purchase file

* Ensure that the appraisal docs are loaded into the proper folders -
Appraisal, Appraisal Invoice, Appraisal HVCC Cert, SSR Report

* Simply Checkmark the Purchase Appraisal UW Review Box
« Hit SAVE

[Whurchase Appraisal UW Review

Review Request Date:

L
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Underwriting Submission Form:

— Function #3 - Suspense Conditions to UW for Review

* This function is used to have SUSPENSE Conditions (only) reviewed to
clear when an Underwriter has issued SUSPENSE conditions

— Ensure that documentation to clear the Suspended Item(s) is/are attached to
the Suspense Condition(s) for u/w review

« The u/w would prefer to see the SUSPENSE conditions cleared in order
to issue a true Conditional Approval

« Simply Checkmark the Suspense Conditions to UW for Review box

 Input Comments as needed
e Hijt S AVE B/Susmse Conditions to UW for Review

UW Suspended Date: //

L
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Underwriting Submission Form:

— Function #4 -Condo Review Request
 This function is used to trigger a FULL Condo Review for a CONV loan
file
— Ensure that appropriate documentation is provided
— This triggers a review by the Condo Review Team 1 oo Reviewe Rounst

* Simply Checkmark the Condo Review Request bc  review request pate:
 Input Comments as nheeded
« Hit SAVE

nations
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Underwriting Worksheet:

— Once conditionally approved, good screen to review document
expiration dates & UW notes

HFAMCC: Is there a DPA/HFAMCC program being used? Indicate Program being used: I .

Credit Expiration Date: 1112172017 | Credit score is 614, reference
$39749574, current mortgage is
reflected on the credit with 74 as
agreed payments. The borrowers will be

Credit Report Document Status:  expired!

Appraisal Expiration Date: i
Fi i o 3 - aisalAnatysis:M £ d i h 11 £
orms Tools Services Appraisal Document Status: expirod er of recor s the seller, fee
Transmittal S ary ) simple, owner occupied. Purchase
CU Rating [:] transaction-sale price is $206000 with

TX Broker Disclosure - -
ULDDPDD v Purchase Appraisal Review Complete Barbara Essig 08/28/2017 08:51 AM Seller paying $6000 towards closing.

Underwriting Submission Form SSR Review: Barbara Essig 08/28/2017 08:51 AM )
Income Analysis: Borrower has been on her job 1.9 mos,

STenTRD] A X Rhaes ["] Escrow Repair Inspection Complete using base income only, supported by
USDA Menegemert ["] condo Review Complete year to date income. There is no job
VA 265.0266 Loan Summery gap. Co-borrower is self employed, his
VA 26-1805 Reasonable Value " - - - e - - .

VA 26-1820 Loan Disbursement Income Expiration Date: 111282017 ) Asset Analysis:
VA 26-6393 Loan Analysis
VA 26-8261A Veteran Status -
VA 26-8923 Rate Reduction WS FHA Case # Exp. Date: 02/09/2018 )

VA Appraisal Status Manager Approval - Override Case # Exp. Date
VA Cert of Eligibility Drivers license provided for the co-
VA Inttial PopUp (] Day1 Qualified at Initial UW borrower and valid green card provided

VA Management [] pay1 Income Qualified for the borrower. SSNs have been
VA Summary verified with the signed social

Downpayment & closing from gift funds,

Asset Expiration Date: 1172812017 :_j gift letters are in the file, funds
were given directly to the title

[71 nav1 4506T Qualified

L
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Encompass — Important Screens & Functionality

Underwriting Worksheet:
— Also where you can review the AUDIT status:

# || File Started 110218 A
4 Qualification finished
4+ Application finished
Sentto processing
@ | Process Open finished Send to Audit - Pre-fund Review 11/28/2018 02:01 PM [_] RA-Send to Audit - Pre-Fund Conditions
# || Submitted 11121
#  Cond.Approvalfinishec 111218 Loan Analysis
4 Resubmittal finished 112718
(8] Approval 1112818
Clear To Close 1172918 Servicing Loan Type: | 1-FHA
Doc Preparation 1173018 Property Valuation Type: | Ful Appraisal
[8) poc signing 1210318 } ‘
Funding 12104118
] Shipping 120518 Servicing Property Type: |1 = Single family detached
(2] Purchased 1211918 Servicing Class Code: |

5 - "o .~

AT REVIEW

[] send to Audit - Early Review -Send to Audit - Early Review Conditions

NLC Loan Type: IFHA Fixed

Purchase Comm Expiration: [W ﬁ
Appraisal Requirement: I Yes v Manu

Escrow Requirement: Yes

<] L] [<]

Property Valuation Effective Date: [ 1112/2018

i

HO6 Indicator: |

Servicing Owner Type: |1sFeeS'|nple

Forms  Tools Services o .
Transmittal Summary i I

ULDD/PDD Underwriter to complete conditional approval: [ Renee Carrow

Texas 50a6 Indicator:

<l <l [« <!

Submitted for Suspense Review:

["] underwriter Suspense Review Complete
Underwriting Appeal Request Form Self Employed: First Time Home Buyer: |No v]  HUD GNND Loan: Student Loan C/O R
Underwriting Submission Form
Underwriting Worksheet ¥ Override PTE Tax Amount PTE Estimated Amount: 135.35 VA IRRRL - Current Morigage Lender:

USDA Management
VA 26-0286 Loan Summary HFAMCC: Is there a DPA/HFAMMCC program being used? |"° - Indicate Program being used: | | DPA Conf

L
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USDA Management:

Req for SFH Loan Guarantee/Resv. Of Funds Tab
(3555-21)

USDA Management
Rural Assistance URLA  Req for SFH Loan Guarantee/Resv. of Funds  Loan Closing Report  Tracking  Fam

i Applicant Information Co-Applicant Information 1

— For USDA loans, much of the data auto-populates & the u/w
completes the rest. This form will be supplied to the processor
to have the borrower sign/date/return prior to the loan being
submitted to USDA for commitment.

eFolder “bucket” |mwme  [uspassssa _

Description USDA RD 3555-21 Request for Single
Family Housing Loan Guarantee




VA 26-0286 Loan SUMMaAry: pemmmemm

The following sections should be manually completed on this
SC ree n : 6a. 6b. Ethnicity and Race from 1003

7. Entitiement Code from VA Cert of Eligibility I 05

8. Entitlement Amount 36,000.00 o
»aBranchofSemce | Marines L]ne#s 7’ 8) 9) and 60
#10, you can veri

10. Status [Separated from Service will come from the COE -

with the borrower or Certificate Of Eligibility

from the DD214 59. Interest Rate 3250 %
60. Funding Fee |Exempt

Fields 47a/ b/ o Shou ld 47a. Loan processed under VA recognized automated underwriting system IYes v |
auto-populate as shown; 47b. Which system was used? [DU ~ 51. Residual Income

Be sure to revise as needed | «c. riskciassification [apPROVE [ V] 52. Residual Income Gui
per AUS

L
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VA 26-0286 Loan Summary:

The following sections should be manually completed on
this screen:

— This section is for VA IRRRLs only and the data would be
obtained from the NEW VA IRRRRL case# assignment obtained

from the VA Portal

For IRRRLS Only

61. Paid In Full VA Loan Number | 63. Original Int Rate |
62. Onginal Loan Amount 65. Onginal Term




VA 2 6 - 1 8 2 O Loa n Di S b u rse m e n t : VA 26-1820 Loan Disbursement

This screen contains many of the “Required Fields” on a VA
loan type - these must be manually input

14. Annual Real Estate Taxes

Relative Not Living with Veteran
15. Insurance

o Mame Tom Unikdr a. Hazard Face Amount

hone EEEET 2 || This data will come from the Hazard AnnualPremum 3
NLR (Nearest Living Relative) © Fiood Face Amount
Disclosure Flood Annual Premium (3}

Current Address
Address 1426 Harborview Drive
City Cleveland

State OH Zip 44102

This will come from the
TAX CERT & HOI

A 7
9GS




VA 26-6393 Loan Analysis: ey

** There is a detailed tutorial for this screen in SharePoint >
Tutorials & Job Aids folder

** This screen MUST be completed prior to initial
submission to u/w on ALL VA loans

— Required Fields:

Maintenance is calculated as

Square footage (from appraisal) X 0.14
Section C - Estimated Monthly Sheiter Expenses i.e. 14 cents per sq. ft.

14 Team of L.0an 30 Y 3250 % 19, Maintenance _

15. Mortgage Payment 1,331.71 20. Utilities

L
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VA 26-6393 Loan Analysis:

— Required Fields: R .
*x ChECk'mark the Creditor include on Line 41 Monthly Payment Unpaid Balance
boxes for debts that T I e
are NOT being paid
in the loan; so for

| |
30400 | 17,470.00 |
410.00 [ 9,031.00
6500 | 1,353.00
|
|
|

25. | KIA MOTORS FINANCE
26. | CB/VICSCRT
27. |
28. |

65.00 1,353.00
25.00 641.00 |
27.00 250.00

. | COMENITY BANK/VCTRSSEC

STATE DEPARTMENT FCU

Purchases, ALL boxes ..
WOUld be Checked 30. Almony / Chid Support

Job Related Expense

unless a debt was Other Expense
Negative Rents

being paid outside of or ...
through the closing

gﬁmnnnnnnm
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.« . Note: if income was Grossed-up
VA 26-6393 Loan AnaIYSIS. for qualifying purposes, it must
be reduced back down to “base”

— Required Fields: amount for RESIDUAL purposes,

using the “lock box” as on line
39

33. Federal Inc Tax 417.58
34. State Inc Tax 0.00
35. Social Security 200.21

The amounts used in the
DEDUCTIONS section

26. Other D will come from

37. Total Deductions 664.61 sses1 | PayCheckCity.Com

38. Net Take-Home Pay 2,564.59 2,564.59
39. Other Net income - 5712.81 5,712.81
40. Total (Sum of lines 33 & 39) 5129.18 8,277.40

nations
lending




VA 26-6393 Loan Analysis:

— Required Fields: VA Residual Requirement

— The Guideline Value is obtained from the VA Lenders
Handbook> Chapter 4 - Item 44 (provided on the next slide)

43. Less Estimated Monthly Shelter Expense (Line 22)

2,364.41

44 Balance Available for Family Support S

Guideline The value on the right of the input
00| 2 4941.99 _Il box for Line# 44 must EXCEED the

45. Ratio (Sum of items 15,16,17,18,21 and 41/ sum of items 32 and 39) B 34.017 % Guideline value

AL Dact Mradd Danard

— *** NOTE.: if the DT
you must increase t
would multiply the

Icﬂﬁb‘ﬂl"l\ﬂl s l

is >/= 41% or you have Refer/Eligible findings,
ne base residual requirement by 20%, so you

pase amount by 1.2 and input this amount in the

Guideline field; example from above $441 x 1.2 = $529.20

20 yewy
9GS



VA 26-6393 Loan Analysis: Residual Incomes by Region

Table of Residual Incomes by Region
For loan amounts of $79,999 and below

Key to Geographic Regions Used in the Preceding Tables

Northeast

Midwest

South

West

$390

$382

$382

$425

Northeast

Maine

Connecticut

Massachusetts

New Hampshire
New Jersey

New York

Pennsylvania
Rhode Island

Vermont

$654

$641

$641

$713

$788

$772

$§772

$859

$888

$868

$868

$967

$921

$902

$902

$1.004

Midwest

Illinois
Indiana

Iowa
Kansas

Michigan
Minnesota

Missouri
Nebraska

North Dakota
Ohio

South Dakota
Wisconsin

Add $75 for each additional member up to a family of 7.

Table of Residual Incomes by Region
For loan amounts of $80,000 and above

Northeast

Midwest

South

West

$450

$441

$441

$491

Alabama

Arkansas
Delaware

Florida

Georgia

District of Columbia

Kentucky

Louisiana
Maryland

Mississippi
North Carolina

Oklahoma

Puerto Rico

South Carolina
Tennessee

Texas
Virginia

West Virginia

$755

$738

$738

$823

$909

$889

$889

$990

$1.025

$1.003

$1,003

$1.117

$1.062

$1.039

$1,039

$1,158

Add $80 for each additional member up to a family of 7.

Alaska
Arizona
California
Colorado

Hawaii
Idaho
Montana
Nevada

New Mexico
Oregon

Utah
Washington
Wyoming

nations
lending




VA 26-8923 Rate Reduction WS:

This form does not always function correctly, so we recommend using the IRRRL
Wksht located on SharePoint in the Agency-VA folder > VA Calculation
Worksheets

Note - Submit this form when requesting guaranty on an Interest Rate Reduction Refinancing Loan.

00-00-0-0000000

SECTION | - INITIAL COMPUTATION
LINE NO. ITEM AMOUNT
1 EXISTING VA LOAN BALANCE (PLUS COST OF ENERGY EFFICIENT IMPROVEMENTS) $0.00
2 SUBTRACT ANY CASH PAYMENT FROM VETERANS $0.00
3 TOTAL $0.00
SECTION Il - PRELIMINARY LOAN AMOUNT
ENTER TOTAL FROM LINE 3 $0.00
ADD 0.000% % DISCOUNT BASED ON LINE 4 $0.00
ADD 1.000% % ORIGINATION FEE BASED ON LINE 4 $0.00
ADD 0.500% % FUNDING FEE BASED ON LINE 4 $0.00
ADD OTHER ALLOWABLE CLOSING COSTS AND PREPAIDS $0.00
TOTAL $0.00
SECTION Il - FINAL COMPUTATION
10 ENTER TOTAL FROM LINE 9 $0.00
11 ADD 0.000% % DISCOUNT BASED ON LINE 10 $0.00
12 SUBTOTAL $0.00
13 SUBTRACT AMOUNT SHOWN ON LINE 5 $0.00
14 SUBTOTAL $0.00
15 SUBTRACT AMOUNT SHOWN ON LINE 7 $0.00
16 SUBTOTAL $0.00
17 ADD 0.500% % FUNDING FEE BASED ON LINE 16, $0.00
18 TOTAL - MAXIMUM LOAN AMOUNT $0.00
NOTE: * MAXIMUM LOAN AMOUNT MAY BE ROUNDED OFF, ST ALWAYS BE ROUNDED DOWN TO AVOID CASH
TO THE VETERAN. ROUND-OFF AMOUNTS OF LESS THAN $50 REQUIRE RECOMPUTATION.

4 T -
FHA SLMMW | VA Loan Comparison | IRRRL Wksht | VA MMC Purch | VA MMC Refi | HASP Wkst nations
lending




VA Appraisal Status:

On this screen, you can locate the SAR - the underwriter who issued the NOV
(Notice of Valuation) for the appraisal

You can track the NOV issuance
You can track the ROV - Reconsideration of Value - if requested

VA Appraisal Status

' Staff Appraisal Reviewer (SAR) _

SAR Name Nancy Van Sooy | Is SAR LAPP Certified ves [ No
SARID 1832 |

 Notice of Value (Nov) < TN

Appraisal Uploaded Date 11/09/2016

Date NOV & Appraisal

Mailed to Borrower ”

NOV Date Received 11/10/2016 ; Appraised Value

NOV Corrections Requested | // Initial NOV Value

|
|
NOV Date Reviewed [ 11/10/2016 | B NOV Value
|
|

NOV Issued Date 111172016

} Reconsideration of Value (ROV) _ NS

nations
lending




VA Cert of Eligibility:

This screen can be utilized to update the information populating to the VA 26-1880, if
needed to request restoration of entitlement

Branch of Service Date Entered Date Separated Officer o

VA 26-6393 Loan Analysis
i " |

VA 26-8261A Veteran Status
VA 26-8923 Rate Reduction WS ] I |
VA Appraisal Status I V] |

VA, Cert of Eligibility
VA Intial PopUp Reserve or National Guard Service

VA Management Branch of Service Date Entered Date Separated Officer o
VA Summary [ |4 |4 |
Voo | I || I

nations
lending




VA Initial PopUp:

— This form should be completed by the Loan Officer when taking
the initial loan application.

— This data will flow to the VA 26-8937 disclosure and the
Nearest Living Relative disclosure

== Tunucu —_—

1
&= (] Shipping finished 12/28M16
| Purchased finished 010417 VETERANS MUST BE LISTED FIRST ON LOAN
# || Reconciled finished 010417

&3] leti 0IMeMT
] Completion Have Not filed a claim for VA disability benefits prior to discharge from

active duty service. (I am presently still on active duty.)
Forms T i »
. . DO NOT have a VA benefit-related indebtedness to my knowledge.
VA 26-6393 Loan Analysis
VA 26-8261A Veteran Status
VA 26-8923 Rate Reduction WS For IRRRLS Only (] 1f RRL Check Box

VA Appraisal Status

VA Cert of Eligibility 61. Paid In Full VA Loan Number | 63. Onginal Int Rate %
VA, Initial PopUp 62. Onginal Loan Amount ‘ 65. Onginal Term mths

VA Management

VA Summary
Nearest Living Relative

VoD E\\j

nations
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VA Management

VA Management - Basic Information Tab: scoomsn auman nen

Much of the information under this tab will flow from the 1003
p a geS Entitement Amount | 36,000.00 |

Branch of Service IMan'nes

The Veteran Information [Sopaaid o Servis

Type of Veteran IReqular Miltary

can be input here from the COE: «wwmmeomevsonsosm o]

Disability Amount Collected J

Also, you can note on this screen if the Borrower/Co-Borr
are married or if you are utilizing entitlement from more
than one veteran

. [:] Borrower / Co-Borrower are Marned
J E] One or More Borrowers Qualifies as a veteran

L
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VA Management

VA Management - Qualification Tab: . .o e

On this screen, you can obtain the Residual Income upon
completion of this section:

Residual Income Guidelines

Click “Get Residual Income”
and the base guideline amount
will populate based on family size

and region

Total Loan Amount 305,995.00 Residual income ) 4,941.99
Family Size 1 Residual Income Guidelines

' Country Region | South v Get Residual Income

Has the Veteran been more than 30 days late on a payment in the last 6 months? (] ves []no 2 494199

There is also a direct link to the
VA Guidelines from this screen:

I

441.00

L
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VA Management - Qualification Tab:

If you are doing a VA IRRRL, the Recoup Period is calculated on this screen:

Previous Loan Information Proposed Loan Inform

Oniginal Loan Amount 983. Proposed Loan Amount
Original Loan Term Proposed Loan Term
Interest Rate . Interest Rate

Original Amortization Type

Monthly Payment (P1)

Total Monthly Payment (PITI)

Existing Loan Date 10411012015

Closing Cost Recoupment
Monthly Decrease in Payments 7219 []
Total Clesing Costs 1,444.45

Recoup Closing Costs INMEENNNNN) 20 Montn(s)

VA Loan Code | RRRL (streamiine Refi)
Time to Recoup Closing Costs 1 Year(s)/ 9 Month(s)

Note: Prepaids are NOT
included in the recoup
calculation

Nations requires a recoup of </= 96
months or the file must be reviewed
by our Risk Team for acceptability

nations
lending




VA Management

VA Management - Tracking Tab: ccceomsn oicsom o

This is another area where you can locate the SAR, track
the NOV status, track the Certificate of Eligibility (COE)
receipt, and input the Borrower(s) CAIVRS number(s)

There is also a notes box for COE Issue History if you have a

complicate situation that you would want to explain:

Certificate of Eligibility

Ordered Date V] ﬂ COE Issue Date I} ﬁ
COE Issue History

| S—




VA Summary:

This is a VA compilation screen with all of the bells &
whistles

Open up the

26-1880 — —| Quick Entry - VA Cert of Eligibility
fields with ke el

i Vet Inf tion for |Bo
a click of a e eteran Informa or I rrower

button! First Name Steven D

Last Name

You can complete the Veteran Info, the NLR info, the
26-8937 questions, the VA Loan Data, get the Residual
Income, obtain VA County Limits, get the Recoup, etc....




VOD/VOE/VOL/VOM/VOR:

These screens compile the data from the 1003 screens for ease of access and
review when opening up eFolder documentation.

The VOL screen is most helpful since this screen allows you
to view/edit all liabilities while retaining the ability to
scroll through the credit report

— ** When you click on VOL, you will see the following PopUp:

Encompass

Do you want to adjust the revolving debt information fields to meet

! Fannie Mae guidelines? Click Yes to set the Payment amount to $10 or
the Factor for Revolving Debt to 5%, whichever is greater. Click No to
keep the current field entries.

L
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TOOLS TAB

Forms  Tools Services

File Contacts

Business Contacts
Conversation Log

TPO Information
Correspondent Loan Status
AUS Tracking

Disclosure Tracking

Fee Variance Worksheet
Arti-Steering Safe Harbor Disclosure
MNet Tangible Benefit
Compliance Review

ECS Data Viewer

Status Online
Amortization Schedule
Co-Mortgagors

Piggyback Loans

Secure Form Transfer
Prequalification

Debt Consolidation

Loan Comparison
Cash-to-Close

Rent vs. Own

Lock Request Form
Yerification and Documentation Tracking
Audit Trail

Trust Accourt

nations
lending




Forms  Tools Services

File Contacts: Fie Contacts

All parties to the loan should be located in this area

Title agent, Seller(s), Seller/Buyer Agent(s), etc must be manually
input
— Be sure to input as much data as possible. If address is not listed on the

purchase contract, you would want to “Google” the info to complete

32  Title insurance Company Attorneys Title Company, Inc Diana Aubin 615-385-5502 Daubini@atctn.com

33  Buyer's Attorney

34  Seller's Attorney Smith Sholar Milliken 615-855-6801

35 Buyer's Agent Neal Clayton Realtors, LLC Jensite Bell 615-297-8543 ienistebeli@comcast net

36 Seller's Agent REMAX Choice Properties BERNIE GALLERANI 615-265-8284 berniei@berniegallerni.com
.37 Seler1 Azir Rasull

B Buyer's Agent

Add to CD Contact Info [] ves Jensite Bell
Company Name | Neal Clayton Reattors, LLC w 615-297-8543
|
|
|
|

| Address 3813 Cleghorn Ave, Ste 101 jenistebel@comcast net
lNashvle
State m | zZip [37221
Line ltem Number [ ]

le y State Li # [257474

L
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Forms  Tools Services

BUSineSS ContaCtS: File Contacts

Business Contacts

If you consistently use contacts such as title agents, you
can email Encompass@NLCLoans.com to request that the
contact information be added to the Business Contacts in

Encompass

— They are unable to set branches up with the access to add
“Companywide”, but they are able to do this for you

— Email the Encompass Team with the Title Agency name,
address, etc to have them added for access from the cardex



mailto:Encompass@NLCLoans.com

Conversation Log:

The Conversation Log should be utilized to document
“material data” changes such as adding/removing
borrowers, loan program changes, revisions to VA funding

fee & reason, etc

U/W will place notes in this area with regard to loan
complications, suspense data, etc

** The Conversation Log goes out with AUDIT FILES, so
you would want to keep this area professional and clear
of unwarranted communication




Forms Tools Services

Disclosure Tracking: disciosrs Trackeg
As the name implies, the Disclosure History is located on this screen

. Disclosure History (4)
Sent Date Method By # of Disclos LE Sent?  CD Sent?
01/06/2017 01:13:47 PM Closing Docs Ord  Patrick Daley(pdaley) No Yes

46

010372017 12:15:09 PM Other Patrick Daley(pdaley) 3 No Yes
2
3

Yes No
Yes No

127302016 Other Joseph Laing(jlaing)
12/08/2016 Email Justin Sopko(jussopko)

If Initial Disclosures were sent via DocuSign, the history will show here, but the
documentation list will appear under the FORMS Tab > DocuSign Disclosure
Request. The unsignhed disclosures will flow to the eFolder > Unsigned
Attachments once signed documents are imported

If Initial Disclosures were sent via Ellie Mae Disclosures, the disclosures will be
accessible from the history. Double-click on the timeline item and select View

Document in the pop-up

20 I
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Disclosure Tracking:
Additionally, the Compliance Timeline, LE Tracking, and CD

Tracking appear on this screen:

— The eConsent is not applicable to DocuSign files; the DocuSign
Certificate, which auto-populates to the eFolder, confirms E-

consent

Disclosure Tracking Tool

Application Date &) 12/08/2016 LE Sent 12/08/2016 CD Sent 01/03/2017
LE Due 12/12/2016 LE Received 12/08/2016 CD Received 01/03/2017
eConsent Q Revised LE Sent 12/30/2016 Revised CD Sent

Intent to Proceed 12/12/2016 Revised LE Received 12/30/2016 Revised CD Received

Earliest Fee Collection 12/12/2016 SSPL Sent 12/08/2016 Post Consummation
Disclosure Sent

Earliest Closing 01/06/2017 Safe Harbor Sent Post Consummation

Estimated Closing 01/06/2017 ™ Disclosure Received




Forms  Tools Services

Fee Variance Worksheet: e Variance Worksheet

This sheet compares the Initial LE, LE Baseline, CD
Baseline, and 2015 Itemization figures to make comparisons
> alerting to variances that would require a cure be applied

i Total Good Faith Amount Initial LE LE Baseline CD Baseline Itemization

12/02/2016 Current
items that Cannot Decrease 0.00 0.00 0.00 0.00
Charges that Cannot Increase * 6,518.03 6,518.03 544463
Charges that in Total Cannot Increase More Than 10% * 1,633.86 433.86 0.00 0.00
Good Faith Amount (Charges) * 8,151.89 6,951.89 544463 544463
Good Faith Limit * 8,315.28 6,995.28 544463 544463

Variance between LE and Itemization £
Difference between LE and CD (Disclosed) -2,707.26

Variance between CD and Itemization 0.00

* Amounts displayed are Net amounts that reflect adjustments.
Tolerance Cure

Required Cure Amount 3
Applied Cure Amount

Resoived by

L
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Fee Variance Worksheet:

Tools Tab > Fee Variance Worksheet:

Fee Variance Good Faith Fee Variance Violated alert appears until: o :
Paths e Change fee to within tolerance Review the
e Redisclose Loan Estimate or Closing Disclosure indicating: 2015
> Indicate Reason for the revised disclosure (e.g. Itemization/LE/

Changed Circumstance — Settlement Charges) CD Tutorial on

If your file is reflecting a required cure, be sure that you have: SharePOint. for a
more detailed

A) Checkmarked the “B” boxes, as applicable . .
_ _ review of this
B) Confirmed that your fee name/fee amount MATCH your prelim CD screen

C) Triggered a COC, if applicable, for any legitimate revisions

If all of this information is properly reflected in the file & a cure is required, it will
to be noted on the Fee Variance Worksheet and applied as a credit on 1003-pa

nations
lending




Compliance Review = Mavent:

This report will auto-run during multiple points of the loan process

The processor should additionally run this prior to submission to u/w for final
TILA/RESPA is the only “fail” approval & review for any FAILS

allowed; you can move forward once

you confirm that APR is not outside Should have no issues unless LO is
of tolerance trying to do a loan in a state in

which he/she isn’t licensed

Higher State . Enterprise
Not Not

PASS PASS PASS PASS Processed PASS Processed PASS PASS

Loan Status: PASS

If Enterprise Rules is fail/
warning, typically related to VA
fees - confirm if fee is
allowable per VA

nations
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Compliance Review = Mavent:

In order to prompt MAVENT to run, you will click on
Compliance Review under the tools tab & click Order

B eFolder |[™ ™=

It may take a
couple of minutes

A
to Process Order | Preview | ViewErorList.. | ClearAlert = Fee Detais...




Compliance Review = Mavent: APR fee versus Non-APR
Fee

Be sure to click the Fee Details button to check APR labeling o [ roiew [ viw o [ o [ resieii |

Anything in

Bomort Fome must be
This list shows ti correcte d on th e pliance report. Problem fees are highlighted in red and should be resolved to get the most accurate Compliance

report.

HUD # &« Enco ipti Amount Paid By Paid To  Encompass APR Compliance APR HOEPAJQM
1101d act Or IMle >ear... Aps 59500 Borrower P False False
1101e Deed Prep Other-Finance Charge 50.00 Borrower P False True
1102b  Closing Fee Settlement or Closing Fee 17500 Borrower P True True False

Borrower Seller (2)  PaidBy /P/B/AIP:

\ 1101. Title Insurance Services
] To I(:ompeﬁive I i 1,550.00
Title Examination 'v| To | Competitive 595.00
Attorney’s Fees \v| To | Competitive 275.00 |

Closing Protection Letter | v | To  Competitive 35.00 |

Abstract Or Tile Search f v | To | Competitive 595.00 |

Deed Prep 'v| To | Competitive 50.00 |

The APR box is not check-marked,

but it should be since the Fee Details
states “Compliance APR” is true.

The box should be check-marked and
Mavent re-run to correct

el

| O
| O

1T~

~1T A1 A17A1

<<l

[dddd
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Co-Mortgagors:

This screen is used to swap borrower position or remove a
borrower from the application

# || Reconciled finished 110416
 [H] Completion 10816

Manage Borrowers

Borrower Pairs Import (3 & & | Delete Borrower Pair

Pair  Borrower
Anti-Steering Safe Harbor Disclosure _

Forms  Tools Services

Vujaklija Jr, David K Vujaklija, Amy R

Net Tangible Benefit
Compliance Review

ECS Data Viewer The Delete Co-Borrower

Status Online b tt l d b d t
Amortization Schedue The MOVE button is HECONRWOUIGEDEESECRT0
eliminate the co-borrower

?‘”‘;Z:f"s used to swap : h
oans oy
o borrower positions rom the app

Secure Form Transfer

Prequalification
Debt Consolidation
Loan Comparison
Cash-to-Close
Rent vs. Own

nations
lending




Audit Trail: |
This screen is covered in Slide #3 A T

Inputting a Field ID# and clicking “Show” will provide you
the input information, if the field is auditable

Example: Field ID# 101 pertains to the borrower’s base

income figure:

Audit Trail

FieldD (101

Description
Date User ID
97272016 2:35:58 PM isills




SERVICES TAB

Forms  Tools Services

» Order Credit Report

» Access Lenders

» Search Product and Pricing
» Request Underwriting

» Order Appraisal

» Order Flood Certification

» Order Title & Closing

» Order Doc Preparation

» Register MERS

» Order AVM

» Order Mortgage Insurance
» Order Fraud/Audit Services
» Request HMDA Management
» Order Additional Services
» Order Verifications

» View My Custom Links

nations
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Order Credit Report: e
This is one of the several locations where credit reports can be ordered/
accessed Crediit Report

CREDIT PLUS is the agency that we use weswies aprocers

Select a provider and click Submit.

ALL credit reports must be pulled
directly through Encompass ’

e T —— Order Method:
' , | New Report if credit is
Usemame:  |dawn2nic : W pai cxpired & a new report is
i needed
Import from website if you
. ot have split a file (new
[V] Save Password . = reissue#) or received a new
- reissue# for a ScorePlus
request

Password: sssssssssee

nations
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Order Credit Report: NOTE: pulling/importing new credit

Password:

Branch ID:

B will OVER-WRITE the current liabilities,
Order Mgbod: | Impot from webste reset any accounts listed to be PAID OFF,
dornt - clear any MANUALLY INPUT PAYMENTS for
collections/student loans, and remove

Options any REO attachments
FICO Score

Selecting Import from website will open up the File Number
field = this is where you will place a new reissue#

** Whenever a new report is imported into Encompass, you
must then IMPORT THE LIABILITIES; this is a separate step

Additionally, be sure to remove any old reports from the eFolder

20 ¥y
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Order Credit Report:

To Import the Liabilities for the new report, go to 1003-
Page 2

Forms T rvices '
L - Subtotal Liquid Assets Value 19,443.62  Total Assets Value 578,443.62
1003 Page 1

1003 Page 2

Order Credit View Credit Liabilities Show Al (VOL)

A Revam D

A

Lien Holder Payment Type

[4] LOANCARE SERVICING CTR 264078 2426 Mortgage
[ CAPITAL MTG SVCS OF TE 113464 609  Mortgage
[] DEPT OF EDUCATION/NELN 8349 98 Instalment
[ BARCLAYS BANK DELAWARE 4297 42 Revolving
[A DFPT OF FNLICATION/NFI N 1 n Installment

[ Motgage Lates: 30 [0 ] 60 [0 ] 90 [0 | 120 [ | [ Numberof Tradelines: 28 Click Import Liabilities
L Foreclosure A pop-up window will
Field Value Field Value appear

[] Delete existing iabiities before importing 7] Import FACTA
[] import Cred Fee to HUD and GFE [ mpot | Cancel

nations
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Order Credit Report:

Once you have pulled/imported a new report, be sure to re-

mark any accounts being PAID
their respective mortgage trad

If you have had to manually in

OFF, and re-attach any REOs to
elines

but any student loan or collection

payments, these figures will a

SO have been over-written with

the import of the new liabilities & need to be re-entered

To reiterate, be sure to REMOVE ANY OLD CREDIT REPORTS

from the eFolder




Access Lenders:

This screen is used to create a FNMA 3.2 file, generally
used to export the file data when submitting a file for
outside underwriting = Jumbo CONV, FHA 203K, or C2P with
disbursements; or running a file through GUS for USDA

— 1) Click Access Lenders
— 2) Select Export file to other partners on the pop-up window

‘Il Lenders

My Lenders Find Lenders

Select a lender and click Continue.

«&* Exportfileto other partners




Access Lenders:

— 3) Click Browse to select where you
would like to save the file

—4) Select “Other” for Export Purpose

— 5) Note “Other” in the Description
— 6) Click Continue

—7) A pop-up will appear to confirm
that the FNMA 3.2 file was created

Export File ll

© Export complete. The 'C:\Users\dthompsoiDocumentsiFNMA EXPORTS\Albert
- Alvarado.fnm' has been created.
IE

|
: OK |_

Lender Transaction Options

Request Type:

Export Fannie Mae formatted file

Export to: l C:A\Users\dthompso\Documents\FNMA,

[ Set as default export directory
Include Log Entry

Create a Shortcut

Please enter the following information to help Ellie Mae keep
the list of Encompass-connected partners up to date:

Export Purpose:  Other

Description: l other

More information

L
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Request Underwriting:

This screen will be used for running DU, LP, and FNMA Early
Check for Fannie/CONV files

Underwriting

My Providers  All Providers

Select a provider and click Submit.

| Fannie Mae DU on ePASS
Freddie Mac's Loan Product Advisor System to System

If the item does not appear on your “My Providers” tab, simply
click on the “All Providers” tab, select the item, and select “Add
to my list”

L
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Order Appraisal:

This screen is used for ordering all appraisal types with the exception of VA
Loan Types (those are ordered using the NLC Appraisal Request screen)

E] Order Appraisal - Approved Appraisers Only

My Appraisers

My Appraisers (15)
Company Name -~ orotie You would select

15t National Appraisal Source More info the AMC, then

AMC Settlement Services More Info

Apex Appraisal Service More Info follow the screen
Apple Appraisal, Inc More Info

A:rai::ﬁek More Info prompts
Collateral Management - ValueLink More Info

CorelLogic Valuation Solutions More Info

Global DMS Appraisal Software More Info

Mercury Network Software More Info

Mortgage Information Services Direct More Info

Nations Valuation Services, Inc. More Info

Nationwide Appraisal Network More Info

Nationwide Property & Appraisal Services More Info

StreetLinks More Info

Valutrust Appraisal More Info

Forms  Tools Services

» Order Credit Report

» Access Lenders

» Search Product and Pricing
» Request Underwriting

» Order Appraisal

» Order Flood Certification

» Order Title & Closing

» Order Doc Preparation

» Register MERS

» Order AVM

[
[
[
[
€4
I
[
[
[
£
[
[
[
;
[
¢
E
E
E

[] show in Alpha Order

e
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Order Additional Services - CorelLogic PTE:

This screen is used for requesting the CorelLogic Property Tax Estimator

r—

Additional Services
Forms  Tools Services »

J A e LY ) (]
A
My Providers iders

» Order Doc Preparation - N S

» Register MERS L Select a provider and click Submit.
» Order AVM

» Order Mortgage Insurance
» Order Fraud/Audit Services
» Request HMDA Management
» Order Additional Services

» Order Verifications

Flles The report
Name

Property Tax Estimate Report 5] Property Tax Estinete Repor populates to
Corelogic PTE Report this eFolder
bucket

nations
lending




Order Additional Services - CorelLogic PTE:

This tool is utilized to ascertain accurate tax figures and aggregate
setup dates:

The first time you access PTE, enter the following
credentials, then check the box to Save Login

Information for future requests. These

The job aid can be
found on SharePoint >
Nations Lending
Processing > LOANCARE
Tax Due Dates &
Corelogic Tax Figures >
e | Quick Reference Guide -

Credit Reports  Verifications Flood Appraisal
Corelogic’

AVMs Collateral Risk & Fraud Marketing Documents COreLO g ic PTE

credentials will be used company-wide,
so please do not disable the password
by exceeding the login attempts.

® User Name = 12096

e Password =310%17*MT1

Property Tax Fequest | Check Status/Mew Resut |

nations
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Order Appraisal:

Once the appraisal order has been placed, you can track the
progress by clicking the “paper” link here:

Once the appraisal is
completed, the person
placing the order will be

>
Forms  Tools Services [E]ADD' sal Order Status
» Order Credit Report t
1)

notified via Email

» Access Lenders / .
/ Order Date User ID Appraiser Appraisal Type  Order Type Due Date Status Order Update

» Search Product and Pricing 20912017 2:34 PM napost ValueLink Software Approved Appraiser or AMC 2212017 7:  reviewed [@ Retrieve View
» Request Underwriting

» Order Appraisal
» Order Flood Certification

» Order Title & Closing Order History (1)

» Order Doc Preparation Date v From To Type Attachments

» Register MERS 2/9/2017 2:34 PM napost ValueLink Software Order Reguest

nations
lending




Order Flood Certification:
We use CBCInnovis, nka FZDS

» Search Product and Pricing Flood Certification

» Request Underwriting Mv Providers Pr
y Prov All Providers

» Order Appraisal

» Order Flood Certification Select a provider and click Submit.

» Order Title & Closing

w Nrdar NAars Dranaratin

You will seleéf Life <;f Loan with Census Tract and click
Order —

Request Type: New Request v

Products: Last Order No.: 16092915264905 (Comments:

[] Basic Flood Certificate Al
[(]  Flood Certificate with Census Tract
Life of Loan

@ Life of Loan with Census Tract

[(]  Census Tract certificate E\\j

nations
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Order Flood Cert:

The Flood Cert will auto-populate into the eFolder

— 2 pages, if NOT in a flood zone

— 3 pages, if the property IS in a flood zone. **The 3rd page will be the
flood disclosure, which must be signed/dated by the borrower & returned

at least 3 days prior to closing

If the Flood Cert goes into “Research”, you will receive a pop-up window
notifying you of this; the Flood Cert will then be sent to you via email, but you
will want to retrieve through Encompass in order to populate the Flood Cert
data (determination#, flood zone, etc) into the Property Information screen

— Click the “paper”, highlight the item, click Retrieve

Order Appraisa | At Name - Requested From i us Date
Order Flood Certification B m Flood Certificate avi ujaklija Jr and... xpire

20 I
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Order Title & Closing:

If you are using a title agency that is integrated with Encompass,
you would be able to use this feature:

Forms  Tools Services

My Title Companies (3)
Company Name &
 Accurate Title

Fidelity National Title Insurance Company (National Directory)
» Order Doc Preparation Mortgage Information Services Direct

» Reaister MERS

» Order Flood Certification

» Order Title & Closing

If not, there is a Title Request Form that can be accessed from the
print icon - Select “Preview” to review & edit as needed

Print

Form Groups Standard Forms Custom Forms

Look In IE; Companywide Selected Forms (1)

Name Name
Q 14, Closing Request Forms [3) Title Reguest Form - NLC Custom v.08112011
"B Addendum to HUD

L
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Order Mortgage Insurance:

This screen would be utilized to obtain a QUOTE for Conventional
MI

This would typically be supplied by the LO prior to issuance of
Initial Disclosures to the borrower

The final MI Cert is ordered by the Underwriter & e il

Matrix located
Forms Tools  Services on SharePoint

el o T

A

that explains
the different

My Providers Al Providers MI types.

» Order Doc Preparation Nations
Select a provider and click Submit.
accepts all MI

» Register MERS ,—
types with the

e T Essent Guaranty, Inc. s T Of
» Order Mortgage Insurance Genworth - Web Connect p .

. D Lender Paid
» Order Fraud/Audit Services ) MGIC - Direct
United Guaranty Monthly

Mortgage Insurance

» Order Title & Closing

—
» Order Flood Certification B

» Reauest HMDA Manaaement > ,
nations

lending




Order Fraud/Audit Services: > Order FraudiAudit Services [

This service is ordered through DataVerify
Input your Username/Password and click ORDER | "o sroees

Select a provider and click Submit.

The report will “pop up” for review, but it does Lomaveryorve |
not auto-populate to the eFolder

— You must print/save/load or print directly to
the Encompass eFolder > DataVerify folder

Name Dataverify v

Description | REVIEW & LOAD into this folder] ‘




Order Fraud/Audit Services - DataVerify, items for review:

Review all HIGH Alerts - provide documentation or explanation to
clear as applicable

Look for notification that borrower(s) filed Fraud Alert(s)

Review Employer Profile Report
— Look for Borrower Associated Business Search

— Address any businesses not otherwise documented in the 1‘1’[7

Review REO Report o
— Look for properties owned by the Company Harme

A & D SPRINGS AND WIRE FORMS L1LC

borrower(s) that are not listed on o NGTON, Ky a4

Contact Name: AMY VUJAKLIJA SSN: XXX-XX-9749  Title: AGENT
the 1003

Review MERS o
— Look for ACTIVE MERS for properties not listed on the 1003

L
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Order Fraud/Audit Services - DataVerify, items for
review:

Review the Loan Participant Analysis

— Ensure that ALL parties to the loan are reflected in the Loan

Contacts area (Tools Tab) & pulled through DataVerify for LDP/
GSA purposes

— You will access the report via DataVerify.com to pull off the
Loan Participant Analysis and the Watchlist Match Report to
place into the LDP/GSA folder

** Be sure to address any “hits”, pulling Advanced Searches from Sam.Gov as
needed

LDP / GSA

v

Place ONLY the Loan Particpant Analysis
and the Watchlist Match Report, pulled from
DataVerify.com in this folder|




Order Verifications:

This function is utilized for
ordering Tax Transcripts/
W-2s/SSA Verifications
etc via DataVerify

— Select the Product

— Click Get Available Years

— Select the years needed

— Attach 4506-T (or SSA Auth)
— Click Submit Order

» Order Fraud/Audit Services [b
» Request HMDA Management

» Order Additional Services

» Order Verifications

» View My Custom Links

|Pmdlcu

1040 - For personal tax transcripts
E] W-2 Information - Employer reported finacial data

Requester Name [Dawn Thompson

Requester Phone: l«0-809-8711

Requester Emait [dawn.thompson@nationslendhg.com

274-82-7076

Get Available Years

My Providers Al Providers

Select a provider and click Submit.

DataVerify 4506T/SSA

The Work Number

If executing the SSA Auth,
select SSA Ver & attach the
Auth, click Submit

AtAZT Authorization Form
4506 or SSA 89 [ Jax

This function can also be used to request a VOE from
theworknumber.com; a salary key is not required

L
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Order Verifications:

Ensure that you are placing
the DocuSign Cert in the SAME FOLDER as the 4506-T prior to
placing the order for tax transcripts via DataVerify

— When you Browse Encompass eFolder to attach the documentation,
you will select the IRS 4506T folder, containing both items needed to

process the transcript request

Name

.ﬂ IRS 4506T - Request for Transcript of Tax Return Classic
Description | ﬂ KARPINSKI DOCUSIGN CERTIFICATE pdf

Name IRS 4506T - Request for Transcript of Tax Re v

L
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